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Limited Warranty 
With respect to the physical CD-ROM and physical documentation enclosed herein, Chauvin 
Arnoux®, Inc. warrants the same to be free of defects in materials and workmanship for a period 
of 1 year from the date of purchase. In the event of notification within the warranty period of 
defects in material or workmanship, Chauvin Arnoux®, Inc. will replace the defective CD-ROM or 
documentation. The remedy for breach of this warranty shall be limited to replacement and shall 
not encompass any other damages, including but not limited to, loss of profit, special, incidental, 
consequential, or other similar claims. 
Chauvin Arnoux®, Inc. specifically disclaims all other warranties, expressed or implied, including 
but not limited to, implied warranties of merchantability and fitness for a particular purpose with 
respect to defects in the CD-ROM and documentation, and the program license granted herein in 
particular, and without limiting operation of the program license with respect to any particular 
application, use or purpose. In no event, shall Chauvin Arnoux®, Inc. be liable for any loss of profit 
or any other commercial damage, including but not limited to, special, incidental, consequential or 
other damages. 

What You Must Do: First request a return authorization form by phone or by fax from AEMC® 
Instruments , then return the diskette along with the signed authorization repair form. Return 
material, postage pre-paid to: 

Chauvin Arnoux®, Inc. 
190, rue Championnet 
75876 PARIS Cedex 18 
FRANCE 

 
Copyright 

Copyright 2000 by Chauvin Arnoux®, Inc. All rights reserved. No part of this manual or 
DataViewer® software may be reproduced in any form or by any means (including electronic 
storage and retrieval or translation into any other language) without prior agreement and written 
consent from Chauvin Arnoux®, Inc., as governed by United States and International copyright 
laws. 

Chauvin Arnoux®, Inc. 
190, rue Championnet 
75876 PARIS Cedex 18 
FRANCE 

 All rights reserved. 

Acknowledgements for product names used in this manual belong to the following companies: 
Windows® 98, Windows® 2000, Windows® ME, Windows® XP, Windows® NT are registered 
trademarks of Microsoft Corp. Acrobat® Reader is a registered trademark of Adobe Systems 
Incorporated. 
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SECTION I 

Disclaimer 
The DataViewer® software and this documentation are provided "AS IS", without warranty of any 
kind. By using this program (the DataViewer® software) you are assuming all liability for anything 
which might occur, including but not limited to physical, emotional or monetary damages. 

Chauvin Arnoux®, Inc. has made every attempt to ensure that this program operates properly. 
Due to the complexity of any program of this size, a change made in one part of the program can, 
and sometimes does, inadvertently generate problems in other areas. It is recommended that you 
save your work regularly (BACK UP your software). 

No part of this manual may be reproduced in any form, or by any means (including electronic 
storage and retrieval or translation into any other language) without prior agreement and written 
consent from Chauvin Arnoux®, Inc., as governed by United States and International copyright 
laws. 

 
Repair and Calibration 

To guarantee that your Chauvin Arnoux®, Inc. instrument, used with the software, complies with 
the factory specifications, we recommend that the instrument be submitted to our factory service 
center at one-year intervals for recalibration, or as required by other standards. 

For instrument repair and calibration: 

Call (33) 01 44 85 44 85 • Fax: (33) 01 46 27 73 89 

Chauvin Arnoux®, Inc. 
190, rue Championnet 
75876 PARIS Cedex 18 
FRANCE 
  

(Or contact your authorized distributor.) Estimates for repairs, normal recalibration, and 
calibration traceable to N.I.S.T. are available. 

Note: All customers must call for an authorization number before returning any 
instrument. 

 
Technical and Sales Assistance 

If you are experiencing any technical problems, or require any assistance with the proper use or 
application of this software, please call our technical hotline: 

Chauvin Arnoux®, Inc. 
190, rue Championnet 
75876 PARIS Cedex 18 
FRANCE 

 Phone: (33) 01 44 85 44 85 

 Fax: (33) 01 46 27 73 89 

 www.chauvin-arnoux.com
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I. DataViewer 

CHAPTER 1: INTRODUCTION 

1.1 DataViewer Introduction 
DataViewer® performs two primary operations, instrument control and data display/ analysis. 

Control and configuration of instruments is performed via the Control Panel dialog box. 

Display and analysis of data is performed using frames placed on the page. 

See Also 

12.1 Establishing a Connection  
1.3 Data Display  

** Available in the professional version.  

1.2 Quick Start dialog 
The Quick Start dialog box provides quick access to the most common operations within 
DataViewer®. The Quick Start dialog box allows four main functions to be performed. These 
functions can also be performed from the main menu, however, this dialog box allows quick 
access to these same commands. The available operations include: 

• Open Instrument Control Panel - selecting this dialog button opens the Control Panel, 
which allows direct control of an attached instrument. ** 

• Create View from Template - selecting this dialog button allows you to select a template file 
defining the view into a specified database. 

• Create View from Scratch - selecting this dialog button loads a blank sheet onto which you 
can place frames for display and analysis of a recording database. ** 

• Open Existing View - this dialog button allows you to open a previously created view. This 
button is disabled until one of the entries in the list box is selected. Initially only More Files… 
is present in this list. However, as you open and save views in DataViewer® they will be 
added to this list. With the most recent view listed under the More Files… entry. 

Selecting the Open Existing View button, while the More Files… entry is highlighted, will cause an 
Open File dialog box to be displayed. Use this dialog box to locate and select the view to be 
opened. Selecting the Open Existing View button, while another view file name is selected, will 
cause that view and any attached database files to be loaded into DataViewer ®. 

The Quick Start dialog box is automatically displayed each time DataViewer® starts, as long as 
the Show this dialog next time DataViewer® starts option is checked. Removing the check 
from this option will prevent the dialog box from being displayed. When disabled, DataViewer® will 
start with a blank sheet onto which you can place frames. You can also use the main menu to 
perform the same tasks (and many more) available in the Quick Start dialog box. 

In addition to being displayed when DataViewer® first starts (if enabled), this dialog box can be 
displayed by selecting the Quick Start command from the File menu. 

See Also 

1.1 DataViewer Introduction 
1.3 Data Display  
18.1 Templates  

** Available in the professional version.  
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1.3 Data Display 
One major function of DataViewer® is the analysis and display of recorded data. DataViewer® 
uses a desktop publishing approach to the display of information. This approach provides a View 
into the Data, hence the name DataViewer®. The view defines the type and placement of 
displayed frames on the printed page. Pages are displayed by DataViewer® using a, What You 
See Is What You Get (WYSIWYG) format. 

You scroll through the displayed pages using the horizontal and vertical scroll bars. If the 
displayed page can fit entirely within the DataViewer® window, the scroll bars are not displayed. If 
the DataViewer® window is too narrow to display a page, then the horizontal scroll bar is 
displayed. If the DataViewer® window is not tall enough to display the page or pages, then the 
vertical scroll bar is displayed. The horizontal scroll bar is used to scroll left and right over the 
page. The vertical scroll bar is used to scroll up and down over the pages. 

DataViewer® displays report pages. When DataViewer® is first run or the New  view toolbar 
icon is selected, a blank page is displayed. Figure 1 illustrates DataViewer® with a blank page 
shown in layout mode. 
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Pages are displayed in white with a gray border around them. If you prefer, the gray borders 
around the pages can be turned off by selecting the Draft display mode. This is accomplished by 
selecting the Draft option from the View menu. Figure 2 illustrates the display of a blank page in 
Draft mode. 

   
In either case, a dotted line is drawn on each page indicating the location of margins. The 
drawing or placement area for frames is within these margins. Frames cannot be placed, moved 
or resized outside the margins of the page. 

1.4 Toolbar 
The toolbar is displayed across the top of the application window, below the menu bar. The 
toolbar provides quick mouse access to many tools used in DataViewer®. Items on the toolbar fall 
into two categories: tools and buttons. A tool changes the mouse pointer to a corresponding 
DataViewer® tool and requires additional user action. A button performs the desired operation 
when the button is pressed (no other action is required). 

To hide or display the Toolbar, choose Toolbar from the View menu (Alt, V, T). 

Click Name Description 

  New Create and open a new view. ** 

 Open Open an existing view.  DataViewer displays the Open 
dialog box, in which you can locate and open the desired 
file. 
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  Save Save the active view or template with its current name.  If 
you have not named the view, DataViewer displays the 
Save As dialog box. 

  Print Print the active view. 

  Print Preview Display the active view, as it will look printed. 

  Cut Remove the selected frame from the view and stores it on 
the clipboard. ** 

  Copy Copy the selected frame to the clipboard. 

  Paste Insert the contents of the clipboard into the active view. ** 

  Select Frame Changes the mouse pointer to the selection tool. 

  Watch Value Enables the display of the Value at Cursor function. 

  Create Frame Changes the mouse pointer to the Create Frame tool. ** 

  Place Graph Changes the mouse pointer to the Create Graph Frame 
tool. ** 

  Link Frame Creates a new frame linked to the currently selected frame.  
The available types of frames will depend of the type of 
frame selected prior to issuing this command. ** 

  Place Text Changes the mouse pointer to the Text Frame tool. ** 

  Place OLE Changes the mouse pointer to the OLE Fame tool. ** 

  Draw Arrow Changes the mouse pointer to the Arrow tool. ** 

  Draw Line Changes the mouse pointer to the Line tool. ** 

  Draw Box Changes the mouse pointer to the Box tool. ** 

  Zoom Selection Changes the mouse pointer to the zoom selection tool. 

  Zoom Previous Resets the display duration and starting display offset of 
the selected graphical frame to the previous zoom extents. 

  Zoom In Increases the zoom magnification of the selected graphical 
frame. 
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  Zoom Out Decreases the zoom magnification of the selected 
graphical frame. 

 Zoom All Resets the zoom magnification to display all of the channel 
measurements in the graph. 

  Pan To Start Sets the display start time for the selected graphical frame 
to the start of the saved data.  The display duration (zoom 
magnification) remains the same. 

  Pan Left Sets the displayed start time for the selected graphical 
frame to a time 90% less than the current time.  Subtracting 
a percentage of the display duration from the start time 
does this.  The display duration remains the same. 

  Step Left Sets the displayed start time for the selected graphical 
frame to a time 10% less than the current time.  Subtracting 
a percentage of the display duration from the start time 
does this.  The display duration remains the same. 

  Step Right Sets the displayed start time for the selected graphical 
frame to a time 10% greater than the current time.  Adding 
a percentage of the display duration to the start time does 
this.  The display duration remains the same. 

  Pan Right Sets the displayed start time for the selected graphical 
frame to a time 90% greater than the current time.  Adding 
a percentage of the display duration to the start time does 
this.  The display duration remains the same. 

  Pan To End Sets the display start time for the selected graphical frame 
to the time of the last data point less the display duration.  
The display duration remains the same. 

  Bring To Front Moves the selected frame to the beginning of the view’s 
frame list. ** 

  Send To Back Moves the selected frame to the end of the view’s frame 
list. ** 

** Available in the professional version.  

1.5 Status Bar 
 

The Status bar is located at the very bottom of the DataViewer® window. To display or hide the 
status bar, use the Status Bar command in the View menu. 

The status bar indicates information about various menu options and the program’s operational 
state. On the left side of the status bar is a one line prompt about highlighted menu options. If no 
menu option is highlighted, it informs you that pressing the F1 function key will display the on-line 
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help. On the right side of the status bar are four panes. The first, indicates the current page and 
number of pages in the view. The last three panes indicate the state of the Caps lock, Num lock 
and Scroll lock keys. 

1.6 Title Bar 
  

The title bar is located along the top of the DataViewer® application window and contains the 
name of the application and active view. 

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their 
title bars. 

A title bar may contain the following elements: 

• Application Control-menu button 
• View Control-menu button 
• Name of the application 
• Name of the active view 
• Minimize button 
• Maximize button 
• Restore button 
• Close (Exit) application button 

1.7 Scroll bars 
Displayed at the right and bottom edges of the view window, the scroll boxes inside the scroll 
bars indicate your vertical and horizontal location in the view. You can use the mouse to scroll 
through the displayed pages using the horizontal and vertical scroll bars. 

If the displayed page can fit entirely within the DataViewer® window, the scroll bars are not 
displayed. If the DataViewer® window is too narrow to display a page, then the horizontal scroll 
bar is displayed. If the DataViewer® window is not tall enough to display the page or pages, then 
the vertical scroll bar is displayed. The horizontal scroll bar is used to scroll left and right over the 
page. The vertical scroll bar is used to scroll up and down over the pages. 

1.8 Page Bar 
Displayed just above the Status Bar is the Page Bar.  The Page Bar allows you to quickly move 
between pages.  The Page Bar contains tabs, one for each page in the view.  To move to any 
given page simply right click the mouse pointer on the associated page tab. 

Selecting Page Bar from the View menu can disable the Page Bar.  It can be re-enable by 
selecting Page Bar from the View menu again.  While the Page Bar is enabled a check is 
displayed next to the Page Bar menu option. 

1.9 Modifying the View 
Another major function of DataViewer® is the analysis and display of recorded data. DataViewer® 
uses a desktop publishing approach to the display of information. This approach provides a View 
into the Data, hence the name DataViewer®. The view defines the type and placement of 
displayed frames on the printed page. Pages are displayed by DataViewer® using, What You See 
Is What You Get (WYSIWYG) format. 

DataViewer® displays report pages. When DataViewer® is first run or the New  view toolbar 
icon is selected, a blank page is displayed. Pages are displayed in white with a gray border 
around them. If you prefer, the gray borders around the pages can be turned off by selecting the 
Draft display mode. This is accomplished by selecting the Draft option from the View menu. 

10 
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In either case a dotted line is drawn on each page indicating the location of margins. The drawing 
or placement area for frames is within these margins. Frames cannot be placed, moved or 
resized outside the margins of the page. 

See Also 

14.1 Creating and Placing Frames  
15.3 Cutting, Copying, and Pasting Frames  
17.7 Page Layout Operations  
18.1 Templates  
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CHAPTER 2: FILE MENU 

2.1 File menu commands 
The File menu offers the following commands: 

Quick Start  Opens the DataViewer Quick Start dialog box. 

New Creates a new view. ** 

New From Template  Opens the Create View from Template dialog box. 

Open Opens an existing view. 

Close Closes an opened view. 

Save Saves an opened view using the same file name. 

Save As Saves an opened view to a specified file name. 

Save As Template  Saves the current view as a Template. ** 

Archive command  Copies the current view and all of the attached database files to a user 
specified location. 

Database  Displays the Database Properties dialog box. 

Page Setup  Displays the Page Setup dialog box. 

Print Prints a view. 

Print Preview Displays the view on the screen, as it would appear printed. 

Send... Sends the active view through electronic mail. 

Exit Exits DataViewer. 

** Available in the professional version.  

2.2 Quick Start command (File menu) 
Use this command to display the Quick Start dialog box. 

See Also 

1.2 DataViewer Quick Start dialog  

2.3 New command (File menu) 
Professional Version  

Use this command to create a new view. 

You can open an existing view with the Open command. 

Shortcuts 

Toolbar:   
Keys: Ctrl+N 
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2.4 New From Template command (File menu) 
Use this command to create a new view of an existing database using a template. 

You can open an existing view with the Open command. 

See Also 

18.2 Create View from Template dialog  
18.1 Templates  

2.5 Open command (File menu) 
Use this command to open an existing view in a new window.  You can open multiple views at 
once.  Use the Window menu to switch among the multiple open views.  See Window 1, 2, ... 
command. 

Shortcuts 

Toolbar:   
Keys: Ctrl+O 

2.6 File Open dialog box 
The following options allow you to specify which file to open: 

Look in: 
Select from the drop down list a directory, drive or network path in which to look for the file. 
Once selected, a list of directories and files (with the specified extension) are display in the 
window under the Look In drop down list. 

File Name 
Type or select the filename you want to open. This box lists files with the extension you select 
in the List Files of Type box. 

List Files of Type 
 Select the type of file you want to open: 
  DataViewer View File (*.dvw) 
  DataViewer Template File (*.dvt) 
  DataViewer Database File (*.dvb) 

2.7 Close command (File menu) 
Use this command to close all windows containing the active view.  DataViewer suggests that you 
save changes to your view before you close it.  If you close a view without saving, you lose all 
changes made since the last time you saved it.  Before closing an untitled view, DataViewer 
displays the Save As dialog box and suggests that you name and save the view. 

You can also close a window by using the Close icon on the view's window, as shown below: 
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2.8 Save command (File menu) 
Use this command to save the active view to its current name and directory.  When you save a 
view for the first time, DataViewer displays the Save As dialog box so you can name your view.  If 
you want to change the name and directory of an existing view before you save it, choose the 
Save As command. 

Shortcuts 

Toolbar:   
Keys: Ctrl+S 

2.9 Save As command (File menu) 
Use this command to save and name the active view.  DataViewer displays the Save As dialog 
box so you can name your view. 

To save a view with its existing name and directory, use the Save command. 

2.10 File Save As dialog box 
The following options allow you to specify the name and location of the file you're about to save: 

Save in: 
Select from the drop down list a directory, drive or network path in which to save the file.  
Once selected, a list of directories and files (with the specified extension) are display in the 
window, under the Save in drop down list. 

File Name 
Type or select the filename you want to save to. 

List Files of Type 
Select the type of file you want to open: 
 DataViewer View File (*.dvw) 

2.11 Save As Template command (File menu) 
Professional Version  

Use this command to save the currently active view as a template.  DataViewer displays the Save 
As dialog box so you can name your template. 

2.12 Archive command (File menu) 
The Archive command gathers the current view and all attached database files and copies them 
to a user specified location.  This is convenient when the database files for a view are not located 
in the same directory as the view file.  Using this command you can copy all the files to a given 
directory.  You can then compress and send these files to another user. 

To archive the current view perform the following steps: 

1. Select Archive from the File menu.  The Choose Directory dialog will be displayed. 
2. Select the drive and directory to which you want the files copied. 
3. Select the OK button.  The files will be copied to the specified location. 
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2.13 Database command (File menu) 
The Database command displayed the Database dialog box.  This dialog box allows you 

• Edit the session information for a database. 

• Export measurement values from a database. 

• Load another database into the Database Inspector. 

2.14 Database dialog box 
The Database dialog box allows you to edit the session informat of a database and to export 
measurement values stored in a database.  The Database dialog box consists of the following 
items: 

Currently Loaded Databases: 
This is a list of database files that have been loaded.  When first displayed this list contains 
the names of all the databases currently loaded by all of the view currently open in 
DataViewer.  Additional databases can be added to the list using the Load another 
database button. 

Export measurements: 
Selecting this dialog button begins the export operation for measurements contained within 
the currently selected database.  When this option is selected the Export Step 1 dialog box is 
displayed. 

Load another database: 
Selecting this dialog button allows you to add another database file to the list of databases.  
Use this button to add a database which you want to modify or export to the Loaded 
Databases list. 

2.15 Edit Session Information 
At the time a database is created you are given the opportunity to specify various operator, site 
and comment information.  This information is called the session properties.  The session 
properties can be changed at a later date using the Database Inspector dialog box.  To edit the 
session properties perform the following steps: 

1. Select Database from the File menu.  The Database dialog box will be displayed. 
2. If the desired database is not listed then load it using the Load another database button. 
3. Select the database whose session information is to be edited from the list of loaded 

databases. 
4. Select the Edit session information dialog button.  The Session Properties dialog box will 

be displayed. 
5. Edit the session fields as needed. 
6. Select the OK dialog button to save the changes into the database. 

2.16 Exporting Measurement Values 
Measurement value stored in a DataViewer database can be export to a comma separated file 
using the Export operation.  To export measurement values from a database perform the 
following steps: 

1. Select Database from the File menu.  The Database dialog box will be displayed. 
2. If the desired database is not listed then load it using the Load another database button. 
3. Select the database whose session information is to be edited from the list of loaded 

databases. 
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4. Select the Export measurements dialog button.  The Export Step 1 – Specify Export File 
Name dialog box will be displayed. 

5. Specify the name of the export file in the supplied edit box (field). 
6. Select the Next >> dialog button.  The Export Step 2 – Select Channel dialog box will be 

displayed. 
7. Select the channel from which the measurement values are to be exported. 
8. Select the Next >> dialog button.  The Export Step 3 – Select Parameters dialog box will 

be displayed. 
9. Select the desired measurement parameters by adding them to the Selected list. 
10. Select the Finish >> dialog button. 
At this point the selected parameters, from the selected database will be exported to the specified 
file. 

2.17 Export Step 1 - Specify Export File Name dialog box 
The Export Step 1 – Specify Export File Name dialog box is the first step in the export 
operation.  It allows you to specify the name of the file to export the measurement values to.  
When first displayed the export file name defaults to the name of the database with .csv given as 
the file extension. 

The name of the database previously selected from which the measurement values will be 
extracted is displayed above the Export File name.  This can not be changed here and shown for 
information only.  To change the database selected you must cancel the export process and 
select a different database in the Database dialog box. 

To continue to the next step in the export operation select the Next >> dialog button. 

To cancel the export operation, select the Cancel dialog button. 

2.18 Export Step 2 - Select Channel dialog box 
The Export Step 2 – Select Channel dialog box displays a list of measurement channels 
contained within the associated database and allows you to select one of these channels to be 
exported. 

In addition the name of the database containing the measurement data is displayed.  The name 
of the export file specified in the previous step is also displayed. 

To continue to the next step in the export operation select the Next >> dialog button. 

To cancel the export operation, select the Cancel dialog button. 

To go back top the previous step, select the << Previous dialog button. 

2.19 Export Step 3 - Select Parameters dialog box 
The Export Step 3 – Select Parameters dialog box allows you to specify the parameters and 
order of the parameters to be exported. 

To select a given parameter to export select it from the Available list and click on the Add>> 
dialog button.  The parameter will be added at the bottom of the Select list. 

Selecting the Add All>> dialog button will add all of the parameters to the export list. 

Selecting the <<Remove All dialog button will remove all (clearing) the parameters in the Select 
list. 

To remove a given parameter from the Selected list select it and click on the <<Remove dialog 
button. 
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The order in which parameters are exported can be changed by selecting each Selected 
parameter and moving it up and down in the list using the Promote and Demote dialog button.  
An item higher in the list is exported before an item lower in the list. 

The parameters selected for export and the order of these parameters can be saved as the 
default by selecting the Make Default button.  The next time a channel of this same type is 
selected for export the Selected list will default to the parameters selected when the Make 
Default button was selected. 

To complete the export operation select the Finish >> dialog button. 

To cancel the export operation, select the Cancel dialog button. 

To go back top the previous step, select the << Previous dialog button. 

2.20 Exit command (File menu) 
Use this command to end your DataViewer session.  You can also use the Close command on 
the application Control menu.  DataViewer prompts you to save views with unsaved changes. 

Shortcuts 
Mouse: Double-click the application's Control menu button. 

  
Keys: Alt+F4 

2.21 Recent file 1, 2, 3, 4 command (File menu) 
Use the numbers and filenames listed at the bottom of the File menu to open the last four views 
you closed.  Choose the number that corresponds with the view you want to open. 

2.22 Send command (File menu) 
Use this command to send the active view through electronic mail.  This command presents a 
mail window with the active view attached to it.  You may then fill out the To: field, Subject: field, 
etc., and add text to the body of the message if you wish.  When you are finished you may click 
the "Send" button to send the message. 
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CHAPTER 3: EDIT MENU 

3.1 Edit menu commands 
The Edit menu offers the following commands: 

Undo Reverse previous editing operation. ** 

Cut Deletes data from the view and moves it to the clipboard. ** 

Copy Copies data from the view to the clipboard. 

Paste Pastes data from the application clipboard into the view. ** 

Paste Special  Pastes data from the Windows clipboard into the view. ** 

Add Page  Adds a page to the active view. ** 

Delete Page  Deletes a page from the active view. ** 

Duplicate Page  Duplicates the currently select page (including all frames on 
that page). 

Insert New Object Inserts and embeds an object, such as a chart or an equation 
in a view. ** 

Links List and edit links to embedded objects. ** 

** Available in the professional version.  

3.2 Undo/Can't Undo command (Edit menu) 
Professional Version  

Use this command to reverse the last editing action, if possible. The undo command is grayed on 
the menu if the undo command list is empty. The undo command list allows you to undo the last 
10 undoable commands. If a non-undoable command is performed, it is not added to the list and 
the list is not modified. For this reason, the undo command list reflects the last 10 undoable 
commands even if non-undoable commands were given. 

The following is a list of commands that can be undone: 

• Move frame 

• Resize frame 

• Place frame 

• Delete frame 

• Change frame properties 

• Delete page (provided the undo buffer can hold copies of all frames on page being deleted).  

Each command that is undone is added to the list of redo commands. Commands such as 
zooming and panning are not added to the undo list and therefore cannot be undone with this 
command, although you can use the zoom previous command to undo a zoom or pan operation. 
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The Delete Page command will empty the undo command list prior to deleting the page. Each 
frame deleted from the page is then added to the undo command list. When the undo command 
is given for the delete page command, the page and all frames that were on it are restored. 
However, if there are more frames on the page being deleted than can fit in the undo list, the 
page deletion command cannot be undone. In which case, the undo command is left empty. If the 
page deletion command cannot be added to the undo command list, you will be warned prior to 
the page being deleted, at which time you can make the final decision if deletion of the page 
should continue. 

Shortcuts 
Keys: Ctrl+Z or 
  Alt-BackSpace 

See Also 

3.3 Redo command (Edit menu)  

3.3 Redo command (Edit menu) 
Professional Version  

Use this command to reverse the last Undo action, if possible. The Redo command is grayed on 
the menu if you cannot reverse your last Undo action. 

Each command undone is added to the list of redo commands. When the view is modified such 
that the new action is added to the undo command list, the redo command list is cleared. For this 
reason, the redo command is available only after an undo command is given and before any 
other command is given. 

Shortcuts 
Keys: Ctrl+Y 

See Also 

3.2 Undo/Can't Undo command (Edit menu)  

3.4 Cut command (Edit menu) 
Professional Version  

Use this command to remove the currently selected frame from the view and put it on the 
clipboard.  This command is unavailable if a frame is not currently selected. 

Cutting a frame to the clipboard replaces the contents previously stored there. 

Shortcuts 

Toolbar:   
Keys: Ctrl+X 

See Also 

15.3 Cutting, Copying, and Pasting Frames  
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3.5 Copy command (Edit menu) 
Use this command to copy the selected frame onto the clipboard. This command is unavailable if 
a frame is not currently selected. 

Copying a frame to the clipboard replaces the contents previously stored there. 

Shortcuts 

Toolbar:   
Keys: Ctrl+C 

3.6 Paste command (Edit menu) 
Professional Version  

Use this command to insert a copy of the clipboard contents into the active view.  Once inserted it 
can be moved and resized as needed.  This command is unavailable if the clipboard is empty. 

Shortcuts 

Toolbar:   
Keys: Ctrl+V 

See Also 

15.3 Cutting, Copying, and Pasting Frames  

3.7 Paste Special command (Edit menu) 
Professional Version  

Use this command to insert a copy of the Windows clipboard contents into the active view. This 
command is unavailable if the Windows clipboard is empty. 

See Also 

15.3 Cutting, Copying, and Pasting Frames  

3.8 Add Page command (Edit menu) 
Professional Version  

Displays the Insert Page dialog box, which allows you to add a page to the view.  To add a page 
to a view, you must specify a page number and whether the new page is to be added before or 
after that page. 

See Also 

17.9 Insert Page dialog box  
3.9 Delete Page command (Edit menu)  
17.13 Printing Operations  

3.9 Delete Page command (Edit menu) 
Professional Version  

Displays the Delete Page dialog box, which allows you to specify the page to be deleted. 

See Also 

17.11 Delete Page dialog box  
3.8 Add Page command (Edit menu)  
17.7 Page Layout Operations  
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3.10 Duplicate Page command (Edit menu) 
The Duplicate Page command inserts a new page into the view and copies the frames on the 
current page to the newly inserted page.  If a parent and child frame (that are linked) are copied 
the new child frame is linked to the new parent frame. 
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CHAPTER 4: VIEW MENU 

4.1 View menu commands 
The View menu offers the following commands: 

Draft  Shows the active view in draft mode. 

Layout  Shows the active view in layout mode. 

Links  Displays the child/parent links between frames. 

Watch  Enables/disables the value at cursor display. 

Grid  Enables/disables the display and snap to grid for frames. 

Toolbar Shows or hides the toolbar. 

Status Bar Shows or hides the status bar. 

Page Bar  Shows or hides the page selection bar. 

4.2 Draft command (View menu) 
Displays pages in draft mode. 

4.3 Layout command (View menu) 
Displays pages in layout mode. 

4.4 Links command (View menu) 
Enables/disables the display of frame identification (FID) numbers and parent identification (PID) 
numbers for each frame.  This allows you to identify associations between frames. 

4.5 Watch command (View menu) 
Use this command to enable/disable the display of the value at cursor for graph frames.  The 
watch value can float (follow) the mouse pointer or can be locked in place.  The Lock Watch and 
Unlock Watch options in the popup menu fix and release the watch text.  To fix the watch text, 
position the mouse pointer at the desired location.  Then click and release the right mouse button.  
The popup menu will be display.  Select the Lock Watch menu option.  To release the watch text, 
perform the same steps except select the Unlock Watch menu option. 

The value displayed in the watch window can be pasted onto the graph at its current location.  To 
paste the text value onto the graph right click the mouse at the desired location and select Paste 
Watch from the popup window. 

In the normal mode of operation the watch text window follows the cursor around the screen.  
You can fix the location of the watch window my right clicking the mouse at the desired location 
and selecting Lock Watch from the popup window.  To release the watch window right click the 
mouse and select Unlock Watch from the popup window. 

4.6 Paste Watch command (Popup menu) 
When the watch value box is enabled you have the option of pasting the value onto the view as a 
text box.  Right clicking the mouse and selecting Paste Watch from the popup menu does this. 

4.7 Grid command (View menu) 
Use this command to turn on and off the layout grid.  When enabled the menu option has a check 
next to it and a grid of points is displayed on the page.  The grid forces frame placement to the 
nearest grid locations. 
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4.8 Toolbar command (View menu) 
Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in DataViewer, such as File Open.  A check mark appears next to the menu 
item when the Toolbar is displayed. 

See Toolbar for help on using the toolbar. 

4.9 Status Bar command (View menu) 
Use this command to display and hide the Status Bar, which describes the action to be executed 
by the selected menu item or depressed toolbar button, currently displayed page and number of 
pages, and keyboard latch state. A check mark appears next to the menu item when the Status 
Bar is displayed. 

See Status Bar for help on using the status bar. 
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CHAPTER 5: FRAME MENU 

5.1 Frame menu commands 
Select Frame  Enables the Select Frame tool, changing the mouse pointer to 

the Frame Selection tool. 

Link Frame  Enables the Link Frame tool, for creating a new frame linked to 
the currently selected frame. ** 

Change Link  Allows you to assign another frame as the parent of a child 
frame. 

Frame Properties  Displays the properties dialog box associated with the currently 
selected frame. 

Send To Back  Moves the selected frame to the end of the views frame list. 

Bring To Front  Moves the selected frame to the beginning of the views frame 
list. 

Lock Frame  Locks down the frame at its current position and size in the 
view. ** 

Unlock Frame  Releases a previous lock placed on a frames placement in the 
view. ** 

New Frame  Enables the Create Frame tool, changing the mouse pointer to 
the Generic frame tool. ** 

Place Graph  Enables the Place Graph tool, changing the mouse pointer to 
the Graph frame tool. ** 

Place Text  Enables the Place Text tool, changing the mouse pointer to the 
Text frame tool. ** 

Place OLE  Enables the Place OLE tool, changing the mouse pointer to the 
OLE frame tool. ** 

Draw Arrow  Enables the Draw Arrow tool, changing the mouse pointer to 
the Arrow tool. ** 

Draw Line  Enables the Draw Line tool, changing the mouse pointer to the 
Line tool. ** 

Draw Box  Enables the Draw Box tool, changing the mouse pointer to the 
Box tool. ** 

** Available in the professional version.  

5.2 Select Frame command (Frame menu) 
Changes the mouse pointer to the Frame Selection tool, allowing a frame to be selected by 
clicking on it.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
15.2 Selecting a Frame  
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5.3 New Frame command (Frame menu) 
Professional Version  

Changes the mouse pointer to the generic frame tool, allowing a frame to be created and placed 
in the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.2 Creating a Generic Frame  

5.4 Place Graph command (Frame menu) 
Professional Version  

Changes the mouse pointer to the Create Graph frame tool, allowing a graph frame to be created 
and placed in the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.20 Creating a Graph Frame  

5.5 Link Frame command (Frame menu) 
Professional Version  

Creates a new frame linked to the currently selected frame.  The available types of frames will 
depend of the type of frame selected prior to issuing this command.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.21 Creating a Linked Frame  

5.6 Change Link command (Frame menu) 
Professional Version 

Assigns another frame as the parent of the currently selected child frame.  To use this command 
you first select the child frame.  Next select the Change Link command from the Frame menu.  
The mouse pointer will change to the Change Link tool.  Then select the frame that is to become 
the new parent for the selected frame.  The new parent must be of the same type as the current 
parent frame. 
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5.7 Place Text command (Frame menu) 
Professional Version  

Changes the mouse pointer to the Text frame tool, allowing a text box frame to be created and 
placed in the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.7 Creating a Text Frame  

5.8 Place OLE command (Frame menu) 
Professional Version  

Changes the mouse pointer to the OLE frame tool, allowing an OLE item to be created and 
placed in the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.9 Creating a OLE Frame  

5.9 Draw Arrow command (Frame menu) 
Professional Version  

Changes the mouse pointer to the Arrow tool, allowing an arrow to be drawn on the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.12 Creating a Arrow Frame  

5.10 Draw Line command (Frame menu) 
Professional Version  

Changes the mouse pointer to the Line tool, allowing a line to be drawn on the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.15 Creating a Line Frame  
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5.11 Draw Box command (Frame menu) 
Professional Version  

Changes the mouse pointer to the Box tool, allowing a box to be drawn on the view.  

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
14.18 Creating a Box Frame  

5.12 Bring To Front command (Frame menu) 
Moves the selected frame to the beginning of the views frame list. This option allows you to 
change the frame selection order. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
5.13 Send To Back command (Frame menu)  
15.2 Selecting a Frame  

5.13 Send To Back command (Frame menu) 
Moves the selected frame to the end of the views frame list. This option allows you to change the 
frame selection order.  For example, if two frames are placed on top of each other in a view the 
top frame will always get selected when using the frame selection tool.  Using this command 
changes the frame selection order and allows the other frame to be selected. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
15.2 Selecting a Frame  

5.14 Lock Frame command (Frame menu) 
Professional Version  

Locks the selected frame at its current location and size. The frame will remain locked until it is 
unlocked via the Unlock Frame command. While a frame is locked, you will not be able to move it 
or change its size. 

Frame locking is useful when you don’t want to accidentally move or change the size of the 
frame. Selecting a frame via the selection tool can result in it inadvertently being moved if it is not 
locked in place. 
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This command is only available when a frame is selected and the selected frame is unlocked. 
Once the selected frame is locked, the Lock Frame command will be grayed and the Unlock 
Frame command will be enabled. Also, while a frame is locked, the cursor does not change to the 
frame resize or move cursor icons. 

See Also 

15.9 Locking a Frame in Place  
5.15 Unlock Frame command (Frame menu)  

5.15 Unlock Frame command (Frame menu) 
Professional Version  

Unlocks the selected frame and allows it to be moved and resized. The frame will remain 
unlocked until it is locked via the Lock Frame command. While a frame is unlocked you will be 
able to move it and change its size. 

Frame locking is useful when you don’t want to accidentally move or change the size of the 
frame. Selecting a frame via the selection tool can result in it inadvertently being moved if it is not 
locked in place. 

This command is only available when a frame is selected and the selected frame is locked in 
place. Once the selected frame is unlocked, the Unlock Frame command will be grayed and the 
Lock Frame command will be enabled. 

See Also 

15.10 Unlocking a Locked Frame  
5.14 Lock Frame command (Frame menu)  

5.15 Frame Properties 
Opens the Properties dialog box associated with the selected frame.  Each frame type has a 
unique properties dialog box. 
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CHAPTER 6: ZOOM MENU 

6.1 Zoom menu commands 
Zoom Tool  Enables the zoom selection tool. 

Zoom In  Increases the zoom magnification. 

Zoom Out  Decreases the zoom magnification. 

Zoom Previous  Zooms to the previous display extents. 

Zoom All  Sets the display extents to include all stored data. 

Step Left  Pans the displayed graph to the left by 10%. 

Step Right  Pans the displayed graph to the right by 10%. 

Pan Left  Pans the displayed graph to the left by 90%. 

Pan Right  Pans the displayed graph to the right by 90%. 

Pan To Start  Pans the displayed graph to the start of the stored data. 

Pan To End  Pans the displayed graph to the end of the stored data. 

6.2 Zoom All command (Zoom menu) 
Adjusts the starting display time and display duration such that all of the trend data is displayed in 
the selected graph frame. 

Shortcuts 

Toolbar:  

See Also 

19.4 Zoom All  

6.3 Step Left command (Zoom menu) 
Sets the display start time for the selected graphical frame to a time 10% less than the current 
time.  Subtracting a percentage of the display duration from the start time does this.  The display 
duration remains the same. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.7 Panning  
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6.4 Step Right command (Zoom menu) 
Sets the display start time for the selected graphical frame to a time 10% greater than the current 
time.  Adding a percentage of the display duration to the start time does this.    The display 
duration remains the same. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.7 Panning  

6.5 Zoom Tool command (Zoom menu) 
Changes the mouse pointer to the zoom selection tool.  This tool allows you to draw a box around 
the area of a graph to zoom in on. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.2 Zoom To Selection  

6.6 Zoom Previous command (Zoom menu) 
Resets the display duration and starting display offset of the selected graphical frame to the 
previous zoom extents. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.3 Zoom Previous  

6.7 Zoom In command (Zoom menu) 
Increases the zoom magnification of the selected graphical frame. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.5 Zoom In  
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6.8 Zoom Out command (Zoom menu) 
Decreases the zoom magnification of the selected graphical frame. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.6 Zoom Out  

6.9 Pan To Start command (Zoom menu) 
Sets the display start time for the selected graphical frame to the start of the saved data.  The 
display duration (zoom magnification) remains the same. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.7 Panning  

6.10 Pan Left command (Zoom menu) 
Sets the display start time for the selected graphical frame to a time 90% less than the current 
time.  Subtracting a percentage of the display duration from the start time does this.  The display 
duration remains the same. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.7 Panning  

6.11 Pan Right command (Zoom menu) 
Sets the display start time for the selected graphical frame to a time 90% greater than the current 
time.  Adding a percentage of the display duration to the start time does this.    The display 
duration remains the same. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.7 Panning  
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6.12 Pan To End command (Zoom menu) 
Sets the display start time for the selected graphical frame to the time of the last data point less 
the display duration.  The display duration remains the same. 

Shortcuts 

Toolbar:   

See Also 

1.4 Toolbar  
19.7 Panning  
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CHAPTER 7: INSTRUMENT MENU 

7.1 Instrument menu commands 
Control Panel  Establishes a connection to an instrument and displays the Instrument 

Control Panel dialog box. ** 

Configure Instrument  Establishes a connection to an instrument and displays the Configure 
Instrument dialog box. 

Download  Retrieves and stores previously recorded measurements stored in an 
instrument. 

Decode Download  Decodes and stores previously downloaded instrument data. 

** Available in the professional version.  

7.2 Control Panel command (Instrument menu) 
Professional Version  

Use this command to open an Instrument Control Panel dialog box.  Once this menu option is 
selected the Select Instrument dialog box will be displayed.  This dialog box will attempt to 
identify the attached instrument.  If it is able to identify the attached instrument, the selection for 
that instrument will be selected automatically.  If the instrument can not be identified automatically 
the Select Instrument dialog box will remain displayed.  If this dialog remains displayed you must 
selected the appropriate instrument followed by the OK button.  Then the Control Panel dialog 
box specific to the instrument will be displayed. 

See Also 

12.2 Select Instrument Dialog box  

7.3 Configure Instrument command (Instrument menu) 
Use this command to open an Instrument Configuration dialog box. Once this menu option is 
selected the Select Instrument dialog box will be displayed.  This dialog box will attempt to 
identify the attached instrument.  If it is able to identify the attached instrument, the selection for 
that instrument will be selected automatically.  If the instrument can not be identified automatically 
the Select Instrument dialog box will remain displayed.  If this dialog remains displayed you must 
selected the appropriate instrument followed by the OK button.  Then the Configure Instrument 
dialog box specific to the instrument will be displayed. 

See Also 

12.2 Select Instrument Dialog box  

7.4 Download command (Instrument menu) 
The Download menu option will initiate the transfer of recorded measurements stored in the 
connected instrument to a database on the PC. 

For a detailed description of downloading recorded data see the help topic for the specific 
instrument you will be accessing. 

See Also 

12.1 Establishing a Connection  

7.5 Decode Download command (Instrument menu) 
Use this command to decode and save into a database the measurements contained in a 
previously downloaded raw recording from an instrument.  This command operates in a similar 
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manner to the Download command except you are asked to specify the raw data file, instead of it 
being acquired from an attached instrument.  This difference aside the operation is identical. 

7.6 Date/Time dialog box 
This dialog box allows you to change the date and time of the clock within the attached 
instrument. The date and time fields will be initialized to the current Date and Time. You can 
accept this default by select the OK button. You can also change the Date and Time as required 
prior to selecting OK. Upon selecting the OK button the date and time within the attached 
instrument will be set to the date and time specified in this dialog box. Selecting the Cancel button 
will close the dialog without sending a set date/time command to the instrument. 

See Also 

12.1 Establishing a Connection  

7.7 Session Properties Dialog box 
The Session Properties dialog box allows you to attach textual information to the recorded data.  
The Session Properties dialog box is illustrated below 

  
This dialog allows you to specify information about the recorded session. This information falls 
into three categories: 

• Operator information - information about the person performing the test. 

• Site information - information about the place and facility the test was performed at. 

• Comments - any additional information you wish to keep with the recorded data. 
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This information is saved along with the recorded data. Selecting the Make Default button will 
save the current field values making them the default for subsequent Session Properties dialog 
boxes. Selecting the OK button will accept the session information and save it and the recorded 
data to the database file previously specified. 

See Also  

14.26 Session Summary Frame 

7.8 Communications Port List 
The Communications Port drop down list box allows you to specify the serial port to use when 
establishing a connection with an instrument. 

7.9 Communication Rate List 
The Communication Rate drop down list box allows you to specify the serial communication 
speed to use when establishing a connection with an instrument. 
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CHAPTER 8: TOOLS MENU 

8.1 Tools menu commands 
Control Panel Options  Displays the Control Panel Options dialog box. 

Directories  Displays the Default Directories dialog box. 

8.2 Control Panel Options command (Tools menu) 
Use this command to display the Control Panel Options dialog box.  This dialog box allows you to 
specify various defaults associated with the Control Panel. 

See Also 

8.3 Control Panel Options dialog box  

8.3 Control Panel Options dialog box 
The Control Panel Options dialog box allows you to change the default behavior of the Control 
Panel and set default parameters for communication with instruments.  The following is a list of 
available options: 

• Open previous real-time windows - placing a check next to this option will cause the Control 
Panel to open and position all real-time windows that were open when it was last closed. **  

• Automatically connect - placing a check next to this option will cause the Control Panel to use 
the specified communication parameters and automatically establish communication with an 
instrument when opened.  When this option is not checked, the communication port and rate 
drop down lists are disabled. 

• Supported Instruments – is a list box containing entries for each of the instruments supported 
by DataViewer . 

• Communication port - specifies the default communication port to be used when connecting 
to the selected instrument. 

• Communication rate - specifies the default communication rate to be used when connecting 
to the selected instrument. 

See Also 
12.4 Automatically Establishing a Connection  
12.5 Automatically Opening Real-Time windows  

 

** Available in the professional version.  

8.4 Default Directories command (Tools menu) 
Use this command to change the default directories DataViewer® uses when storing and 
retrieving file. 

See Also 

8.5 Default Directories dialog box  
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8.5 Default Directories dialog box 
The Default Directories dialog box allows you to change the default directories DataViewer® uses 
when storing and retrieving files.  When DataViewer® displays File Open and File Save dialog 
boxes the default directory used is determined by the type of file being opened or saved and the 
directories specified in this dialog box.  The following is a list of available options: 

• Views: Default directory for view files. 

• Templates: Default directory for template files. 

• Layouts: Default directory for real-time layout files. 

• Database: Default directory for database files. 

• Inst. Config: Default directory for instrument configuration files. 

The default directory is changed by either entering it into the associated edit box or by using the 
Browse button.  Selecting the Browse button will display the Choose Directory dialog box.  Use 
this dialog box to locate the desired directory.  Once the directory has been located and selected 
click on the OK button. 

See Also 

8.6 Choose Directory dialog box  

8.6 Choose Directory dialog box 
The following options allow you to select a desired directory: 

Directory name 

Type or select the name of the desired directory.  Double clicking on a upper level 
directory will close that list and display directories at the level of the selected directory.  
Double clicking on a lower level directory will open that directory and display the 
directories (if any) within it.  

Drives 

Is a drop down list of drives either local or network mapped that are currently available on 
the computer.  Once another drive is selected the directory tree will be updated to reflect 
the directories on that drive. 

OK 

Closes the dialog and returning to the calling dialog changing the directory listed in that 
dialog. 

Cancel 

Closes the dialog box without changing the directory in the calling dialog. 

8.7 Channel Trace Colors command (Tools menu) 
This menu option allows you to specify the default colors to be assigned to graph traces 
associated with specific trend measurements.  When this command is selected the Trace Colors 
dialog box will be displayed with the Available measurements list initialized to those available in 
the Configure Instrument dialog box. 

See Also 

8.9 Trace Colors dialog box  
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8.8 Input Trace Colors command (Tools menu) 
This menu option allows you to specify the default colors to be assigned to graph traces 
associated with specific hardware input channels.  When this command is selected the Trace 
Colors dialog box will be displayed with the Available measurements list initialized to those 
associated with various capture mechanisms within the instrument. 

See Also 

8.9 Trace Colors dialog box  

8.9 Trace Colors dialog box 
This dialog box allows you to specify the default color of traces associated with either channel 
measurements and hardware inputs.  The type of association is determined by the command 
selected to display this dialog box. 

This dialog displays a list of measurements with a rectangle filled with an associated color.  
These colors are the defaults used when displaying associated traces in the control panel and 
DataViewer frames. 

To change the associated trace color, highlight the desired entry and select a color from the drop 
down list.  If a desired color is not listed in the drop down list you can specify the color via the 
Red, Green and Blue fields.  These three fields allow you to specify the intensity of each of the 
base colors for a composite color.  You can also use the color picker to specify a color.  The color 

picker is displayed by clicking on the color palette icon .  A color picker dialog will be 
displayed. 

Selecting the OK button will save the changes as the new default trace colors and close the 
dialog box.  Selecting the Cancel button will close the dialog box without saving and changes you 
may have made. 

See Also 

8.7 Channel Trace Colors command (Tools menu)  
8.8 Input Trace Colors command (Tools menu)  
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CHAPTER 9: WINDOW MENU 

9.1 Window menu commands 
The Window menu offers the following commands, which enable you to arrange multiple windows 
of multiple views in the application window: 

New Window Creates a new window that displays the same view. 

Cascade Arranges windows in an overlapped fashion. 

Tile Arranges windows in non-overlapped tiles. 

Arrange Icons Arranges icons of closed windows. 

Window 1, 2, ... Goes to specified window. 

9.2 New command (Window menu) 
Use this command to open a new window with the same contents as the active window. You can 
open multiple windows to display different parts of a view at the same time. If you change the 
contents in one window, all other windows containing the same view reflect those changes. When 
you open a new window, it becomes the active window and is displayed on top of all other open 
windows. 

9.3 Cascade command (Window menu) 
Use this command to arrange multiple opened windows in an overlapped fashion.  

9.4 Tile command (Window menu) 
Use this command to arrange multiple opened windows in a non-overlapped fashion. 

9.5 Window Arrange Icons Command 
Use this command to arrange the icons for minimized windows at the bottom of the main window. 
If there is an open view window at the bottom of the main window, then some or all of the icons 
may not be visible because they will be underneath this view window. 

9.6 1,2, ... command (Window menu) 
DataViewer® displays a list of currently open view windows at the bottom of the Window menu. A 
check mark appears in front of the name of the active window. Choose a view from this list to 
make its window active. 
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CHAPTER 10: HELP MENU 

10.1 Help menu commands 
The Help menu offers the following commands, which provide you assistance with this 
application:  

Contents  Offers you an index to topics on which you can get help. 

How To  Lists topics on how to perform various functions. 

CA 6543 Megohmmeter  Displays the CA 6543 Megohmmeter PDF document. 

CA 6547 Megohmmeter  Displays the CA 6547 Megohmmeter PDF document. 

Qualistar  Displays the Qualistar PDF document. 

User's Guide  Displays the User’s Guide PDF document. 

Tutorial  Displays the Tutorial PDF document. 

Templates  Displays the Templates PDF document. 

Register  Opens the on-line registration form. 

About DataViewer  Displays the version number of the DataViewer application. 

10.2 Contents command (Help menu) 
This help option displays the main help index dialog box.  From this starting point you can find 
help on all aspects of DataViewer. 

10.3  How To command (Help menu) 
Use this command to display the opening screen of Help.  From the opening screen, you can 
jump to step-by-step instructions for using DataViewer and various types of reference information.   

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen. 

10.4 Model CA 6543 Megohmmeter (Help menu) 
Opens the Adobe Acrobat PDF formatted document file for the Model CA 6543 Megohmmeter. 

10.5 Model CA 6547 Megohmmeter (Help menu) 
Opens the Adobe Acrobat PDF formatted document file for the Model CA 6547 Megohmmeter. 

10.6 Qualistar (Help menu) 
Opens the Adobe Acrobat PDF formatted document file for the Qualistar. 

10.7 User's Guide (Help menu) 
Opens the Adobe Acrobat PDF formatted DataViewer user’s guide. 

10.8 Tutorial (Help menu) 
Opens the Adobe Acrobat PDF formatted DataViewer tutorial. 

10.9 Templates (Help menu) 
Opens the Adobe Acrobat PDF formatted user’s guide for templates. 
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10.10 Register command (Help menu) 
Use this command to open the on-line registration form.  The form is opened using your default 
web (html) browser.  You must have a web browser installed and a connection to the Internet 
available to use this feature. 

10.11 About DataViewer command (Help menu) 
Use this command to display the copyright notice and version number of your copy of 
DataViewer. 

10.12 Help Using Help Command 
Use the Context Help command to obtain help on some portion of DataViewer.  When you 
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and 
question mark.  Then click somewhere in the DataViewer window, such as another Toolbar 
button.  The Help topic will be shown for the item you clicked. 

Shortcut 

Toolbar:   
Keys: Shift+F1 
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CHAPTER 11: SYSTEM AND CONTROL MENUS 

11.1 Size command (System menu) 
Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys. 

 
After the pointer changes to the four-headed arrow: 

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to 
the border you want to move.   

2. Press a DIRECTION key to move the border. 
3. Press ENTER when the window is the size you want. 
Note:  This command is unavailable if you maximize the window. 

Shortcut 
Mouse: Drag the size bars at the corners or edges of the window. 

11.2 Move command (Control menu) 
Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys. 

 
Note:  This command is unavailable if you maximize the window. 

Shortcut 
Keys: Ctrl+F7 

11.3 Maximize command (System menu) 
Use this command to enlarge the active window to fill the available space. 

Shortcut 
Mouse: Click the maximize icon  on the title bar; or double-click the title bar. 
Keys: Ctrl+F10 enlarges a view window. 

11.4 System Minimize Command 
Use this command to reduce the DataViewer window to an icon. 

Shortcut 
Mouse: Click the minimize icon  on the title bar. 
Keys: Alt+F9 

11.5 Next Window command (view Control menu) 
Use this command to switch to the next open view window.  DataViewer determines which 
window is next according to the order in which you opened them. 

Shortcut 
Keys: Ctrl+F6 
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11.6 Previous Window command (view Control menu) 
Use this command to switch to the previous open view window.  DataViewer determines which 
window is previous according to the order in which you opened them. 

Shortcut 
Keys: Shift+Ctrl+F6 

11.7 Close command (Control menus) 
Use this command to close the active window or dialog box. 

Double-clicking a Control-menu box is the same as choosing the Close command. 

 
Note:  If you have multiple windows open for a single view, the Close command on the view 
Control menu closes only one window at a time.  You can close all windows at once with the 
Close command on the File menu. 

Shortcuts 
Keys:  Ctrl+F4 closes a view window 
  Alt+F4 closes the view window or dialog box 

11.8 Restore command (Control menu) 
Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command. 

11.9 Switch to command (application Control menu) 
Use this command to display a list of all open applications.  Use this "Task List" to switch to or 
close an application on the list. 

Shortcut 
Keys: Ctrl+Esc 

Dialog Box Options 

When you choose the Switch To command, you will be presented with a dialog box with the 
following options: 

Task List 
Select the application you want to switch to or close. 

Switch To 
Makes the selected application active. 

End Task 
Closes the selected application. 

Cancel 
Closes the Task List box. 

Cascade 
Arranges open applications so they overlap and you can see each title bar.  This option does 
not affect applications reduced to icons. 
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Tile 
Arranges open applications into windows that do not overlap.  This option does not affect 
applications reduced to icons. 

Arrange Icons 
Arranges the icons of all minimized applications across the bottom of the screen. 
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CHAPTER 12: INSTRUMENTS 

12.1 Establishing a Connection 
To establish communication between DataViewer and a supported instrument select one of the 
options from the Instrument.  At this point the Connection dialog box will be displayed (illustrated 
below). 

  
The Connection dialog box allows you to specify the communication port and data transfer rate to 
be used during this session. Select the communication port from the Communication Port drop 
down list. Then select the data transfer rate from the Communication Rate drop down list. Once 
the port and data rate has been specified, click on the Start button. Click the Cancel button if you 
decide not to establish a connection at this time. 

When the Start button is selected the Select Instrument dialog box will be display (illustrated 
below). 

  
The Select Instrument dialog box is used to identify an attached instrument.  When first displayed 
it attempts to automatically identify the instrument.  If it is able to identify the attached instrument 
(using the previously specified communication parameters) it will automatically close and proceed 
with the appropriate operation. 
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While displayed the Select Instrument dialog box will continuously try to identify the attached 
instrument.  Cycling between all know instrument types.  The dialog box will remain displayed 
until the attached instrument is identified or until the OK button or Cancel button is selected. 

If the Select Instrument dialog box is unable to identify the attached instrument it will remain 
displayed, in which case you must manually select the desired instrument. 

See Also 

12.4 Automatically Establishing a Connection  
12.3 Communication Port Connection Dialog box  
12.2 Select Instrument Dialog box  

12.2 Select Instrument Dialog box 
The Select Instrument dialog box is used to identify an attached instrument.  When first displayed 
it attempts to automatically identify the instrument.  If it is unable to identify the instrument a list 
will be display from which you must select the desired instrument.  If prompted, select the desired 
instrument followed by the OK button.  At this point the Connection dialog box will be displayed 
(illustrated below). 

See Also 

12.1 Establishing a Connection  

12.3 Communication Port Connection Dialog box 
The Connection dialog box allows you to specify the communication port and data transfer rate to 
be used during this session. Select the communication port from the Communication Port drop 
down list. Then select the data transfer rate from the Communication Rate drop down list. Once 
the port and data rate has been specified, click on the OK button. Click the Cancel button if you 
decide not to establish a connection at this time. 

See Also 

12.1 Establishing a Connection  

12.4 Automatically Establishing a Connection 
Once you are confident in the communication parameters, you can instruct DataViewer® to 
automatically establish a connection with an instrument as needed. An automatic connection will 
use the communication port and rate specified in the Control Panel Options dialog box. 

To enable automatic connection, select Control Panel Options from the main Tools menu. This 
will display the Control Panel Options dialog box. Placing a check next to Automatically Connect 
will cause the Control Panel to automatically establish a connection with an instrument using the 
specified communication port and rate. 

See Also 

8.3 Control Panel Options dialog box  

12.5 Automatically Opening Real-Time windows 
Professional Version  

You can instruct DataViewer® to open all the windows that were open the last time the Control 
Panel was closed. This option allows you to customize the default layout of windows within the 
Control Panel. 
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To enable automatic connection, select Control Panel Options from the main Tools menu. This 
will display the Control Panel Options dialog box. Placing a check next to Open previous real-
time windows will cause the Control Panel to automatically open the windows that were open 
the last time the Control Panel was closed. 

See Also 

8.3 Control Panel Options dialog box  
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III. Frames 

CHAPTER 13: INTRODUCTION TO FRAMES 

13.1 What is a Frame 
DataViewer® frames are a rectangular box in which graphical items such as: lines, text and 
graphs are drawn. All items displayed by DataViewer® are contained in frames. 

13.2 Graph Frame 
A Graph Frame provides a graphical look into the database to which it is attached. The database 
is attached to the frame when it is created. 

A Graph Frame provides additional tools for viewing the underlying database. These tools provide 
zoom and pan operation. In addition, individual traces and waveform snapshots can be selected 
using the Select Frame tool. 

Normally, the Select Frame tool is used to select a frame for modification. However, in this graph 
frame it can be used to select individual waveforms and trend traces. A trace is selected if any 
part of it is drawn within a few screen pixels of where the selection tool is when the left mouse 
button is pressed.  

Notice, as a trace is selected, handles similar to those of the frame handles, are drawn over the 
trace. If more that one trace is drawn within the proximity of the selection tool, when clicked again 
the next trace will be selected. This will continue until all traces within the selection tools proximity 
have been selected, at which point clicking the left mouse button again will select the first trace 
and the process will repeat. 

The Graph Frame can be the parent frame for child frames. The types of child frames that it can 
support are: 

• Waveform Analysis Frame: When selecting a trace within the graph frame, the attached child 
frames will be updated to reflect the new selection. The types of Waveform Analysis include: 
Waveform Snapshot, Harmonic Bar Graph and Harmonic Text Summary. 

• Graph Legend Frame: Displays the names of the traces displayed on the graph. 

• Session Summary Frame: Displays user and instruments supplied information about the 
session that contains the recorded data. 

• Micro-Graph Frame: Displays a sub-section of the parent frame. 

• Meter Frame: Displays spot values of a parent frame. 

• Exceedence Statistics Frame: Displays the statistics for an individually selected exceedence 
trace within the graph area. 

• Exceedence List Frame: Displays a list of exceedences contained within the attached 
database. 

• Channel List Frame: Displays a list of records for selected channels contained within the 
parent graph frame. 

See Also 

14.20 Creating a Graph Frame  14.21 Creating a Linked Frame  
19.7 Panning  19.1 Zooming  

13.3 Linked Frame Overview 
The linking of frames in a view allows you to define one frame by the contents of another frame. 
For example, an exception report frame can be linked to a graph frame which displays the trend 
data of a recording. The exception report frame can be set to list exceptions for the entire 
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recording or just the portion displayed in the graph frame, in which case, zooming in and out of 
the displayed graph will cause the exception report to automatically update based on the 
displayed data. 

As another example, a Harmonic Text Summary frame can be linked to a graph displaying 
waveforms. When a waveform is selected, the Harmonic Text Summary frame will be updated 
based on the selected waveform. 

In addition, multiple frames can be linked to a single frame. For example, we can link Waveform 
Snapshot, Harmonic Bar Graph and Harmonic Text Summary frames to a trend graph that 
contains waveforms. When we click on and select a waveform, all three of the attached frames 
will automatically be updated for the selected waveform. 

In the previous example, the trend graph is referred to as the Parent frame. The Waveform 
Snapshot, Harmonic Bar Graph and Harmonic Text summary are Child frames. In DataViewer® a 
parent frame can have multiple child frames, although each child frame can only have one parent 
frame. This means, that a child frame cannot be attached to multiple parent frames. 

Attaching a child frame to a parent creates a hierarchy of linked frames with the top most parent 
frame controlling the display of the lower level frames. Frames that have attached child frames 
cannot be deleted before all of the attached child frames are deleted. This is not something that 
you have to worry about doing accidentally, as the Cut command is disabled for parent frames 
with attached child frames. 

The following is a list of parent frames and the type of child frames that can be linked to them: 

Graph frame: Waveform Graph, Harmonic Bar Graph, Harmonic Text Summary, Graph Legend, 
Session Summary, Micro-Graph, Meter, Exceedence Statistics, Exceedence List and Channel 
List. 

Micro-Graph frame: Waveform Graph, Harmonic Bar Graph, Harmonic Text Summary, Graph 
Legend, Meter, Exceedence Statistics, Exceedence List. 

See Also 

14.1 Creating and Placing Frames  
14.21 Creating a Linked Frame  
14.24 Waveform Analysis Frame  
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CHAPTER 14: CREATING FRAMES 

14.1 Creating and Placing Frames 
Professional Version  

Display frames are placed on the page using a frame creation tool.  The type of frame created 
depends on the tool selected from the toolbar.  The following is a list of available toolbar tools and 
the type of frame they create: 

 
Graph tool: creates a waveform or trend frame (depending on the data 
specified). 

 Link Frame tool: creates a new frame linked to the currently selected 
frame. 

 Text tool: creates a text frame. 

 OLE tool: creates an OLE (Object Linking and Embedding) frame. 

 
Arrow tool: creates an arrow frame. 

 
Line tool: creates a line frame. 

 
Box tool: creates a box frame. 

Each of these frame creation tools creates a specific type of frame. 

In addition to these tools, the generic Create Frame  tool can be used to create any of the 
previous types or one that is not covered by any of the specific tools. The generic frame tool will 
ask you to specify the type of frame via a dialog box. The specific tools operate in the same 
manner, except you are not asked to specify the type of frame (it is implied by the specific tool). 

To create a frame, select one of the frame creation tools by left clicking the mouse pointer on it. 
The mouse pointer will change to that tool while it is over a valid area of the page. When the 
mouse pointer is outside the page margins it will be the normal (default) pointer. 

The following detail the creation of frames: 

14.2 Creating a Generic Frame  14.20 Creating a Graph Frame  
14.21 Creating a Linked Frame  14.7 Creating a Text Frame  
14.9 Creating a OLE Frame  14.12 Creating a Arrow Frame  
14.15 Creating a Line Frame  14.18 Creating a Box Frame  

14.2 Creating a Generic Frame 
Professional Version  

The other frame creation tools are used to place a specific type of frame on the page. The tools 
given on the toolbar provide a shorter path to creating these frames. You can use the generic 
Create Frame tool to place these and other frames on the page. To create a frame perform the 
following steps: 

1. Left click the mouse pointer on the Create Frame  tool. The mouse pointer will become 
this tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

3. Click and hold the left mouse button. 
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4. Drag the mouse to the location on the page where the lower right corner of frame is to be 
located. As you move the mouse pointer, a dotted box is displayed. This dotted box shows 
the size and location of the frame being created. 

5. Release the mouse button. The Frame Type dialog box will be displayed. 
6. Select the type of frame to be created from the displayed list. 
7. Once the frame type is specified, select the OK button to proceed with the creation of the 

frame. If you decide not to create the frame, select the Cancel button. 
8. Once the frame type is specified and the OK button is selected, the corresponding properties 

dialog box will be displayed. Refer to the previous sections for an explanation of each frame 
type’s properties dialog box. 

9. Once the properties have been specified select the OK button. 
See Also 

14.1 Creating and Placing Frames  

14.3 Frame Type Dialog 
Professional Version  

Specify the type of frame to be created and placed in the box you just created.  Once the frame 
type is selected and the OK button pressed, the frame properties dialog box (specific to the 
specified frame type) will be displayed. 

See Also 

14.1 Creating and Placing Frames  

14.4 Text Box Frame 
A Text Box frame displays text within a given object frame. The text within the frame is static, in 
that, it does not change. It only changes when you change it. 

See Also 

14.7 Creating a Text Frame  
14.5 Text Box Properties dialog box  

14.5 Text Box Properties dialog box 
This dialog box allows you to specify the text to be displayed in the associated frame.  

Type the text you want displayed into the edit window. You can change the font used to display 
this text by clicking on the Font button and specifying the font attributes. As in any text editor, 
pressing the Enter key will create a new line. Pressing the Tab key will position the cursor to the 
next tab position. You can change the default tab positions by selecting the Tabs button to display 
the Tabs dialog box. 

You can have DataViewer® wrap text within the associated frame rectangle by selecting the 
Enable word wrap option. Placing a check in the associated box does this. 

You can specify if a box should be drawn around the frame, as well. Placing a check in the Draw 
box around frame option causes a box to be drawn around the object frame. Clearing the check 
box prevents a box from being drawn around the frame. 
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You can also have the frame grow with the text. Placing a check in the Grow frame with text 
option enables this feature. When the Enable word wrap and Grow frame with text options are 
both checked, the width of the frame is maintained and the height is adjusted to fit the displayed 
text. If the Enable word wrap option is disabled and the Grow frame with text is enabled, the 
width and height of the frame will be adjusted to meet the requirements of the displayed text. 

See Also 

14.7 Creating a Text Frame  
14.6 Tabs dialog box  

14.6 Tabs dialog box 
The Tabs dialog box allows you to specify the position of tab stops within a text frame. 

You can specify the default tab position to be every multiple of a given measurement. Specifying 
a width in the Default tab stops field does this. 

You can also force tab stops at given locations. To do this, enter a value into the Tab stop 
position field and select the Set button. Tabs positions will be placed starting with the entries in 
the list, with each subsequent tab being placed based on the default tab stops value. 

You can remove an individually specified tab position by highlighting it and selecting the Clear 
button. You can also remove all tab positions in the list by clicking the Clear All button. 

14.7 Creating a Text Frame 
Professional Version  

The following steps describe the process of creating a text frame. To place a text frame on the 
page, perform the following steps: 

1. Left click the mouse pointer on the Place Text  tool. The mouse pointer will become this 
tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the page where the lower right corner of frame is to be 

located. As you move the mouse pointer, a dotted box is displayed. This dotted box shows 
the size and location of the frame being created. 

5. Release the mouse button. The frame properties dialog will be displayed. 
6. Enter the text box text in the edit field of this dialog. 
7. Specify if word wrap is to be used with this text. Placing a check next to the Enable word 

wrap check box will enable word wrap. When enabled, the specified text will be drawn such 
that it does not extend beyond the right side of the frame. A new line will be started if a word 
to be displayed will extend beyond the right side of the frame. If word wrap is not enabled, 
the specified text will be drawn on a single line. 

8. Specify if a box is to be drawn around the frame. Placing a check next to the draw box 
around frame check box will cause lines to be drawn on each side of the frame. 

9. Specify if the frame should be enlarged to the size of the specified text. If word wrap is 
enabled, the text frame will grow down if it is not large enough to contain the text. If word 
wrap is not enabled, then the frame will grow in width to fit the size of the text. If this option is 
not checked, the frame size will not change to contain the text. 

10. Specify the font to be used by clicking on the Font button. The font dialog box will be 
displayed. Specify the desired font name, style, size, effects and script. Once the font 
attributes are specified, click on the OK button to accept the font. Click on the Cancel button 
to cancel changing the font. 
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11. Once the desired properties for this new Text frame are specified, select the OK button. The 
frame will be created using the specified properties. 

See Also 

14.5 Text Box Properties dialog box  
14.1 Creating and Placing Frames  

14.8 Object Linking and Embedding frame 
Professional Version  

An Object Linking and Embedding (OLE) frame is used to embed items from other applications 
into a view. The object is contained within the specified frame. 

See Also 

14.9 Creating a OLE Frame  

14.9 Creating a OLE Frame 
Professional Version  

The following steps describe the process of creating an OLE (Object Linking and Embedding) 
frame on the page: 

1. Left click the mouse pointer on the Place OLE  tool. The mouse pointer will become this 
tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the page where the lower right corner of the frame is to be 

located. As you move the mouse pointer, a dotted box is displayed. This dotted box shows 
the size and location of the frame being created. 

5. Release the mouse button. The frame properties dialog box will be displayed.  
6. Specify if it is a new or existing object by clicking on Create New or Create from File, 

respectively. When creating a new object, select the Object Type from the displayed list. 
When embedding an existing object (Create from File), specify the file name. Once specified, 
select the OK button. If created from a file, the object will be embedded into the page and 
displayed. If creating a new object, the appropriate application will open allowing you to 
create the new object. 

See Also 

14.1 Creating and Placing Frames  

14.10 Arrow Frame 
An Arrow Frame is used to draw an arrow on a view. 

See Also 

14.12 Creating a Arrow Frame  
14.11 Arrow Properties dialog box  

14.11 Arrow Properties dialog box 
The Arrow Properties dialog box allows you to customize the display of the associated arrow. 

This dialog box is displayed by right clicking on the arrow and selecting Properties from the pop 
up menu. The properties dialog box will be displayed. 
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From this properties dialog box you can specify the line thickness (in pixels), the line color and 
the size of the arrowhead. 

See Also 

14.12 Creating a Arrow Frame  

14.12 Creating a Arrow Frame 
Professional Version  

Error! Reference source not found.The following steps describe the process of creating an 
Arrow frame: 

1. Left click the mouse pointer on the Draw Arrow    tool. The mouse pointer will become 
this tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the page where the lower right corner of the frame is to be 

located. As you move the mouse pointer a dotted box is displayed. This dotted box shows the 
size and location of the frame being created. 

5. Release the mouse button. The Arrow will be drawn from the point the mouse was pressed to 
the point it was released, with the arrowhead being placed at the point the button was 
released. 

6. Change the arrow properties by right clicking on the arrow and selecting Properties from the 
pop up menu. The properties dialog box will be displayed. From this properties dialog box 
you can specify the line thickness (in pixels), the line color and the size of the arrowhead. 

7. Once the arrow properties have been specified, select the OK button. To cancel the changes 
to the arrow select the Cancel button. 

See Also 

14.11 Arrow Properties dialog box  
14.1 Creating and Placing Frames  

14.13 Line Frame 
A Line frame is used to draw a line on a view.  

See Also 

14.15 Creating a Line Frame  
14.14 Line Properties dialog box  

14.14 Line Properties dialog box 
The Line Properties dialog box allows you to customize the display of the associated line. 

This dialog box is displayed by right clicking on the line and selecting Properties from the pop up 
menu. The properties dialog box will be displayed. 

From this properties dialog box you can specify the line thickness (in pixels) and color of the line. 

See Also 

14.15 Creating a Line Frame  
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14.15 Creating a Line Frame 
Professional Version  

The following steps describe the process of creating a Line Frame: 

1. Left click the mouse pointer on the Draw Line  tool. The mouse pointer will become this 
tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the page where the lower right corner of the frame is to be 

located. Notice, as you move the mouse pointer, a dotted box is displayed. This dotted box 
shows the size and location of the frame being created. 

5. Release the mouse button. The line will be drawn from the upper left to the lower right 
corners of the frame. 

6. Change the line properties by right clicking on the line and selecting Properties from the pop 
up menu. The properties dialog box will be displayed. From this dialog box you can specify 
the line thickness (in pixels) and the line color. 

7. Once the line properties have been specified, select the OK button. To cancel the changes to 
the line, select the Cancel button. 

See Also 

14.14 Line Properties dialog box  
14.1 Creating and Placing Frames  

14.16 Box Frame 
A Box Frame is used to draw a rectangular box on a view.  

See Also 

14.18 Creating a Box Frame  
14.17 Box Properties dialog box  

14.17 Box Properties dialog box 
The Box Properties dialog box allows you to customize the display of the associated box. 

This dialog box is displayed by right clicking on the box and selecting Properties from the pop up 
menu. The properties dialog box will be displayed. 

From the properties dialog box you can specify the line thickness (in pixels), color and fill style of 
the line. 

See Also 

14.18 Creating a Box Frame  

14.18 Creating a Box Frame 
Professional Version  

The following steps describe the process of creating a Box Frame: 

1. Left click the mouse pointer on the Draw Box  tool. The mouse pointer will become this 
tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 
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3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the page where the lower right corner of the frame is to be 

located. As you move the mouse pointer a dotted box is displayed. This dotted box shows the 
size and location of the frame being created. 

5. Release the mouse button. The box will be drawn from the upper left to the lower right 
corners of the frame. 

6. Change the box properties by right clicking on the box and selecting Properties from the pop 
up menu. The properties dialog box will be displayed. From this properties dialog box you can 
specify the line thickness (in pixels), the line color and the fill style. 

7. Once the box properties have been specified select the OK button. To cancel the changes to 
the box select the Cancel button. 

See Also 

14.17 Box Properties dialog box  
14.1 Creating and Placing Frames  

14.20 Creating a Graph Frame 
Professional Version  

The following steps describe the process of creating a Graph Frame. The creation of other frame 
types is identical to this procedure except for the properties dialog box. Each frame type will have 
its own unique properties dialog box. To place a graph on the page perform the following steps: 

1. Left click the mouse pointer on the Place Graph  tool. The mouse pointer will become this 
tool while it is within the margins of the page. 

2. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the page where the lower right corner of the frame is to be 

located. As you move the mouse pointer a dotted box is displayed. This dotted box shows the 
size and location of the frame being created. 

5. Release the mouse button. The frame properties dialog box will be displayed. 
6. Select a channel to be displayed by highlighting it (left clicking the mouse pointer) in the 

Available channels list, then click on the Add>> button. The selected channel will be added 
to the Selected channels list. You can remove channels from the selected channel list by 
highlighting it and clicking on the <<Remove button. You can add all of the available 
channels to the selected channels list by clicking on the Add All>> button. You can also 
remove all channels from the selected channel list by clicking on the <<Remove All button. 

7. You can change the color used to draw each of the channels by highlighting its entry in the 
selected channel list and selecting an alternate color from the Line color drop down list. You 
can also specify a color, other than one in the color list, by specifying the amount of each 
color component in the Red, Green and Blue fields. 

8. Once the desired properties for this new Graph frame are specified, select the OK button. 
The frame will be created using the specified properties. 

See Also 

14.19 Channel Graph Properties dialog box  
14.1 Creating and Placing Frames  
13.2 Graph Frame  
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14.21 Creating a Linked Frame 
Professional Version  

A linked frame is a frame that obtains its display data from a parent frame.  Linking frames allows 
interaction between the linked frames.  For more information about linked frames see Linked 
Frame Overview. 

To link a frame to another, perform the following steps: 

1. Select the frame to be linked using the frame selection tool . The selected frame will be 
displayed with resize handles. Both the Link Frame menu option and the Link Frame tool are 
enabled only when a frame capable of being a parent (able to support child frames) is 
selected. If the selected frame can not support child frames, the menu option and toolbar icon 
will be grayed. 

2. Select Link Frame from the Edit menu or the Link Frame tool  from the toolbar. The 
Child Frame Type dialog box will be displayed. The Child Frame Type dialog box allows you 
to specify the type of frame to be created and linked to the previously selected parent frame. 
The Type list contains only child frame types, which can be linked to the selected parent 
frame. 

3. Select the type of child frame to be created and linked from the Type list. 
4. Once the child frame type is specified, select the OK button to proceed with the creation and 

linking of the frames. If you decide not to create the frame, select the Cancel button. After 
selecting OK the cursor will change to the Linked frame creation tool. 

5. Move the frame tool to the location on the page where the upper left corner of the frame is to 
be placed. 

6. Click and hold the left mouse button. 
7. Drag the mouse to the location on the page where the lower right corner of the frame is to be 

located. As you move the mouse pointer a dotted box is displayed. This dotted box shows the 
size and location of the frame being created. 

8. Release the mouse button. The Properties dialog box specific to the type of linked frame 
previously specified will be displayed. 

9. Once the properties have been specified, select the OK button. The child frame is created 
and linked to the parent frame selected in step 1 above. 

This procedure creates a hierarchy of linked frames with the top most parent frame controlling the 
display of the lower level frames. 

See Also 

14.1 Creating and Placing Frames  
13.3 Linked Frame Overview  

14.22 Graph Legend Frame 
The Graph Legend Frame is a child frame linked to the Graph Frame. The Graph Legend frame 
displays the names of the recorded channels displayed in its parent graph frame. The name of 
each displayed channel is preceded by a short line segment drawn in the same color as its 
associated trace. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.23 Graph Legend Properties dialog box  
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14.23 Graph Legend Properties dialog box 
The Graph Legend Properties dialog box is used to customize the way the Graph Legend frame 
is displayed. This dialog box is illustrated below: 

 
This dialog has two options: 

• Draw box around frame; and 

• Grow frame with text; and 

• Display channel units 

When the Draw box around frame option is checked, a box is drawn around the Graph Legend 
frame. To prevent a box from being drawn, remove the check mark. 

When the Grow frame with text option is checked, the bottom right corner of the Graph Legend 
frame is automatically adjusted to enclose all lines in the legend. If traces are removed from the 
Graph parent frame, the height of the frame will decrease accordingly. Likewise, the height will 
increase if additional traces are displayed in the parent Graph frame. The width of the frame is 
also adjusted as needed. 

See Also 

14.22 Graph Legend Frame  

14.24 Waveform Analysis Frame 
The Waveform Analysis Frame is a child frame linked to either a Channel Graph or Micro-Graph 
frame. The Waveform Analysis frame displays the waveform selected in its parent frame. The 
waveform can be displayed in the following forms: 

• Waveform Snapshot – displays the selected waveform. 

• Harmonic Bar Graph – displays a harmonic bar graph of the selected waveform. 

• Harmonic Text – displays a harmonic text summary of the selected waveform. 

The type of waveform analysis is specified in the Waveform Analysis Properties dialog box.  This 
dialog box is displayed either by double clicking the left mouse button while the frame selection 
tool is over the desired frame, or by selecting Properties from the popup menu. Right clicking the 
mouse button with the frame selection tool over the desired frame displays the popup menu. 

In addition to the analysis type, you can specify if the harmonic text summary is to display values 
in RMS, peak amplitude or percent of fundamental. Selecting the appropriate radio button in the 
Individual Harmonics group box does this. 

You can quickly move between captured waveforms (selected for display) using the pan 
commands. Selecting Pan To Start displays the first captured waveform. Selecting Pan To End 
displays the last captured waveform. Selecting the Step Right or Step Left displays the next or 
previously captured waveform. When stepping through the captured waveforms, the selection will 
move from each waveform for the channel associated with the currently displayed waveform. 
After the last waveform for the current channel, the first (or last depending on direction of 
stepping) waveform for the next (or previous) channel will be displayed. 
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Placing a check in the Zoom parent frame when panning will cause the parent graph to zoom 
to the time period associated with the newly selected waveform. If the parent frame is a Micro-
Graph, then the auto zooming function will result in the Micro-Graphs frames parent being 
updated (gray area) to display the relative time and location of the selected waveform. 

You can also freeze the data displayed by the analysis frame at its current state. Placing a check 
in the Lock frame data field of the Waveform Analysis Properties dialog box does this. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.24 Waveform Analysis Frame  

14.25 Waveform Analysis Properties dialog box 
The Waveform Analysis Properties dialog box is used to specify the type of waveform analysis 
and to specify various display options. The options available are: 

Analysis Type 
Contains a group of radio buttons, which specifies the type of analysis to be performed on the 
associated waveform. 

Individual Harmonics 
Contains a group of radio buttons, which specifies how the individual harmonics are 
displayed in a Harmonic Text Summary.  The values can be displayed as RMS, peak 
amplitude or percent of fundamental. 

Zoom parent frame when panning 
Is a check box, which when selected causes the parent frame to zoom to the time period 
associated with the displayed waveform.  This occurs when issuing a pan command while the 
waveform analysis frame is selected. 

Lock frame data 
Is a check box, which freezes the data used to display the frame at their current values.  
When the frame data is locked selecting a waveform in the parent frame does not change the 
data displayed in this child frame.  

OK button 
Closes the dialog box and saves changes you have made.  

Cancel button 
Closes the dialog box without saving any changes you have made.  

See Also 

14.24 Waveform Analysis Frame   

14.26 Session Summary Frame 
The Session Summary Frame is a child frame linked to the Graph Frame.  The Session Summary 
frame displays a textual summary of its parent frame.  You can customize the summary text 
displayed using the Session Summary Properties Dialog box.  This summary text is obtained from 
the Session Summary information entered at the time the recorded channel data was saved to 
the database. 

The Session Summary frame contains static and dynamic text. Static text is displayed as it was 
typed into the Session Summary Properties dialog box. Dynamic text is generated through field 
substitution. The value of the parent frame of the specified field is substituted for the field name. 

Surrounding the session summary field name with square brackets specifies dynamic text. For 
example, if the Operator Company Name field of the recorded data is AEMC® Instruments, 
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placing the text [Operator Company Name] in the Summary Text edit box will result in AEMC® 
Instruments being displayed in its place on the page. 

Dynamic text substitution is useful for templates that create a view when session data is attached. 
The field name will reflect the name contained in the attached database (which may be different 
from database to database). 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.27 Session Summary Properties Dialog  

14.27 Session Summary Properties Dialog 
The Session Summary Properties dialog box allows you to specify what is displayed in its 
associated Session Summary Frame (see Figure 11). 

 
This dialog box contains an edit box into which you type the static and dynamic text to be 
displayed in the Session Summary Frame. It also contains a list box from which you can select 
field names, field values and field codes. 

Static text is displayed as it is typed into the Summary Text edit box. Dynamic text is generated 
through field substitution. The value of the specified field as obtained from the Session Summary 
Frames parent is substituted for the field name. 

Surrounding the Session Summary field name with square brackets specifies dynamic text. For 
example, if the Operator Company Name field of the recorded data is AEMC Instruments®, 
placing the text [Operator Company Name] in the Summary Text edit box will result in AEMC 
Instruments® being displayed in its place on the page. 
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Dynamic text substitution is useful for templates that create a view when session data is attached. 
The field name will reflect the name contained in the attached database (which may be different 
from database to database). 

Session Summary Fields can be added to the Summary Text in a number of ways. First, place 
the cursor in the Summary Text edit box where the Summary Field is to be inserted. Next, click 
on the Session Summary Field (in the list box) to be inserted. The next step depends on what you 
want inserted. To insert the field name as static text, click on the Insert Field Name button 
(notice brackets are not placed around the field name). To insert the field value as static text, click 
on the Insert Field Value button (notice that the value displayed in the list box is inserted). To 
insert the field value as dynamic text, click on the Insert Field Code button (notice that the name 
of the field surrounded by square brackets is inserted). 

If the selected Field does not have a current value associated with it, the Insert Field Value 
button will be grayed and unavailable. 

As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will 
position the cursor to the next tab position. You can change the default tab positions by selecting 
the Tabs button to display the Tabs dialog box. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes.   

See Also 

14.26 Session Summary Frame  
14.6 Tabs dialog box  
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14.28 Micro-Graph Frame 
A Micro-Graph Frame provides a graphical look into the database attached to its parent frame. As 
with the Channel Graph Frame, the Micro-Graph frame provides tools for viewing the underlying 
database. These tools provide zoom and pan operations. The parent Channel Graph frame will 
gray the area of its graph window to represent the time period being displayed by this child frame. 
As you zoom and pan the Micro-Graph frame, the parent Channel Graph will update the grayed 
area of its graph. This provides a quick reference into the Macro view (parent graph) of the graph 
that this Micro-Graph is displaying. 

Normally, the Select Frame tool is used to select a frame for modification. However, in this graph 
frame it can be used to select individual waveforms and trend traces. A trace is selected if any 
part of it is drawn within a few screen pixels of where the selection tool is when the left mouse 
button is pressed.  

Notice, as a trace is selected, handles similar to those of the frame handles, are drawn over the 
trace. If more than one trace is drawn within the proximity of the selection tool when clicked 
again, the next trace will be selected. This will continue until all traces within the selection tools 
proximity have been selected, at which point clicking the left mouse button again will select the 
first trace, and the process will repeat. 

The Micro-Graph Frame can be the parent frame for child frames. The types of child frames that it 
can support are: 

• Waveform Analysis Frame: When selecting a trace within the graph frame, the attached child 
frames will be updated to reflect the new selection. The types of Waveform Analysis include: 
Waveform Snapshot, Harmonic Bar Graph and Harmonic Text Summary. 

• Graph Legend Frame: Displays the names of the traces displayed on the graph. 

• Meter Frame: Displays spot values of a parent frame. 

• Exceedence Statistics Frame: Displays the statistics for an individually selected exceedence 
trace within the graph area. 

• Exceedence List Frame: Displays a list of exceedences contained within the attached 
database. 

See Also 

14.21 Creating a Linked Frame  

14.29 Micro-Graph Properties dialog box 
This dialog box consists of two pages.  The first (Channels) page allows you to select the 
channels to be displayed in the trend graph frame. 

Channels dialog page 

Placing a check in the Display channels selected in parent graph option causes the Micro-
Graph frame to automatically display the same channels selected in the parent graph frame.  
Removing the check from this option allows you to customize the display of channels in the 
frame.  While this option is enabled the remaining options on this page of the dialog box are 
disabled.  This option must be disabled to allow the customization of the associated frame using 
the fields on this page of the dialog box. 

Select a channel to be displayed by highlighting it (left clicking the mouse pointer on it) in the 
Available channels list, then click on the Add>> button. The selected channel will be added to 
the Selected channels list. You can remove channels from the selected channel list by 
highlighting it and clicking on the <<Remove button. You can add all of the available channels to 
the selected channels list by clicking on the Add All>> button. You can also remove all channels 
from the selected channel list by clicking on the <<Remove All button. 
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You can change the color used to draw each of the channels by highlighting its entry in the 
selected channel list and selecting an alternate color from the Line color drop down list. You can 
also specify a color, other than one in the color list, by specifying the amount of each color 
component in the Red, Green and Blue fields. In addition, you can use the color picker to select 
from a wider range of colors. 

The color picker is displayed by clicking on the color palette icon . A color picker dialog will be 
displayed. 

Template Filter: Allows you to specify how channels should be included when this view is saved 
and used as a template to open other databases.  The options available are 

• Channel Type Only: when selected any channel of the same type (for example 
voltage waveforms) as those currently selected for display will be automatically 
included for display regardless of the channels code and modifier. 

• Channel Type and Code: when selected any channel of the same type and with the 
same measurement code will be automatically included for display regardless of the 
channels modifier. 

• Channel Type, Code and Modifier: when selected only channels with the same data 
type, same measurement code and same measurement modifier will be automatically 
included for display. 

Delete frame if selected channel list is empty when opening via a template: this option 
allows you to mark the frame (and all of the attached child frames) for deletion if the Selected 
channels list is empty after opening a database when this view is used as a template.  Placing a 
check next to this option marks the frame for deletion if empty.  When not checked the frame will 
not be deleted even if the database does not contain and similar channels (as defined by the 
Template Filter option). 

Scales dialog page 

The second (Scales) page of this dialog box allows you to specify how the vertical scales of the 
associated graph are to be drawn.  Two check boxes are provided with an associated edit box. 

Placing a check next to Automatically adjust vertical scale maximum instructs DataViewer® to 
automatically adjust the upper end of the vertical scale to accommodate the displayed channels.  
Removing the check from this option causes the upper limit of the vertical scale to be fixed at the 
specified value. 

Placing a check next to Enable lower limit for vertical scale maximum allows you to specify a 
value for which the upper end of the vertical scale is not allowed to go below. 

Placing a check next to Automatically adjust vertical scale minimum instructs DataViewer® to 
automatically adjust the lower end of the vertical scale to accommodate the displayed channels.  
Removing the check from this option causes the lower limit of the vertical scale to be fixed at the 
specified value. 

Placing a check next to Display channel units on graph causes the units for each channel 
selected for display to be displayed on the left side of the graph.  When this option is selected you 
can also over-ride the default channel units and display other text as units. 

When Display channel units on graph is selected you can check Display channel 
units as.  Doing so allows you to enter any text you would like displayed for the vertical 
scale units in the edit box to the right. 

Placing a check next to Synchronize parent/child frame display period cause all graph frames 
linked to this frame to zoom and pan along with this frame. 

Placing a check next to Highlight relative time period of child frames causes this frame to gray 
the area of the frame relative to the child frames display period. 
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Once the desired properties for this new Graph frame are specified, select the OK button. The 
frame will be created using the specified properties. 

See Also 

14.1 Creating and Placing Frames  
14.28 Micro-Graph Frame  

14.30 Meter Frame 
A Meter Frame provides a textual summary of the samples within one pixel of its parent frame. 
The finest resolution, which the parent frame can draw, is one screen (or printer) pixel. 
Depending on the display magnification, one pixel width can contain one or more sample points. 
In addition, the time associated with each pixel position is dependent on the zoom magnification 
and display offset. 

A vertical line is displayed in the parent frame at the pixel position associated with the current 
meter time. As you pan left and right, this vertical line will move to reflect the new position of the 
meter. Selecting Pan To Start moves the meter to the first pixel position of the parents graph. 
Selecting Pan To End moves the meter to the last pixel position. Pan Left and Pan Right step 
the meter up to 10 pixels left and right, respectively. Step Left and Step Right moves the meter 
position 1 pixel left and right, respectively. 

The information displayed in the Meter frame includes the time associated with the pixel position 
of the parent graph frame. It also displays the minimum, maximum and average values of the 
samples for each displayed channel for the associated single pixel time period. In addition, a 
short line of the same trace color and name of the associated parent frame trace is displayed 
along side the measurement values. Also, the number of samples within the single pixel time 
period are indicated at the end of each trace name. 

See Also 

14.21 Creating a Linked Frame  

14.31 Meter Properties dialog box 
The Meter Properties dialog box allows you to customize the display of the meter frame.  Placing 
or removing the check next to each of the following options enables and disables the display of 
the associated parameter. 

Start time – when checked the start time for the meter in the associated graph is displayed. 

Duration – when checked the duration of the meter line in the associated graph is displayed. 

Minimum value – when checked the minimum value in the sample set is displayed. 

Maximum value – when checked the maximum value in the sample set is displayed. 

Average value – when checked the average value in the sample set is displayed. 

First sample value – when checked the value of the first sample in the sample set is displayed. 

Number of samples – when checked the number of samples in the sample set is displayed. 

14.32 Exceedence Statistics Frame 
The Exceedence Statistics frame is a child frame linked to either a Channel Graph of Micro-
Graph frame.  The Exceedence Statistics frame displays a textual summary of the exceedence 
trace selected in its parent frame.  You can customize the text displayed using the Exceedence 
Statistics Properties dialog box.  The displayed text is obtained from the exceedence trace 
selected in the parent frame. 

The Exceedence Statistics frame contains static and dynamic text. Static text is displayed as it 
was typed into the Exceedence Statistics Properties dialog box. Dynamic text is generated 
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through field substitution. The value obtained from the parent frame of the specified field is 
substituted for the field name. 

Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. 
For example, if the Exceedence Type field of the selected exceedence trace is Sag, placing the 
text [Exceedence Type] in the Exceedence Statistics Text edit box will result in Sag being 
displayed in its place on the page. 

Dynamic text substitution is useful for templates that create a view when recorded data is 
attached to it. The field name will reflect the name contained in the attached database, which may 
be different from database to database. 

You can pan quickly between exceedence captures selected for display. Selecting Pan To Start 
displays the first exceedence event. Selecting Pan To End displays the last captured 
exceedence event. Selecting the Step Right or Step Left displays the next or previously 
captured event. 

When stepping through the captured exceedence events, the selection will move from each 
exceedence for the channel associated with the currently displayed event. After the last event for 
the current channel, the first (or last depending on direction of stepping) event for the next (or 
previous) channel will be displayed. 

Enabling Zoom parent frame when panning (see Exceedence Statistics Properties dialog box) 
will cause the parent graph to zoom to the time period associated with the newly selected event.  
If the parent frame is a Micro-Graph then the auto zooming function will result in the Micro-
Graphs frames parent being updated (gray area) to display the relative time and location of the 
selected waveform. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.32 Exceedence Statistics Properties dialog box  
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14.33 Exceedence Statistics Properties dialog box 
The Exceedence Statistics Properties dialog box allows you to specify what is displayed in its 
associated Exceedence Statistics frame. The first page of the Exceedence Statistics Properties 
dialog box is illustrated in the following figure. 

 
This page of the dialog box contains an edit box into which you type the static and dynamic text to 
be displayed in the Exceedence Statistics frame. It also contains a list box from which you can 
select field names, field values and field codes. 

Static text is displayed as it is typed into the Text edit box. Dynamic text is generated through field 
substitution. The value of the specified field as obtained from the Exceedence Statistics frames 
parent is substituted for the field name. 

Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. 
For example, if the Exceedence Type field of the selected exceedence trace is Sag, placing the 
text [Exceedence Type] in the Exceedence Statistics Text edit box will result in Sag being 
displayed in its place on the page. 

Dynamic text substitution is useful for templates, which create a view when session data is 
attached to it. The field name will reflect the name contained in the attached database, which may 
be different from database to database. 

Exceedence Statistics fields can be added to the Text edit box in a number of ways. First, place 
the cursor in the Text edit box were the Exceedence Statistics field is to be inserted. Next, click 
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on the Exceedence Statistics field (in the list box) to be inserted. The next step depends on what 
you want inserted. To insert the field name as static text, click on the Insert Field Name button 
(notice brackets are not placed around the field name). To insert the field value as static text, click 
on the Insert Field Value button (notice that the value displayed in the list box is inserted). To 
insert the field value as dynamic text, click on the Insert Field Code button (notice that the name 
of the field surrounded by square brackets is inserted). 

If the selected Field does not have a current value associated with it the Insert Field Value 
button will be grayed and unavailable. 

As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will 
position the cursor to the next tab position. You can change the default tab positions by selecting 
the Tabs button. This will display the Tabs dialog box. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

Additional display attributes are selected on the dialogs second properties page. This page is 
illustrated in the following figure: 

 
This page of the dialog box allows you to select the type of exceedence to select when 
performing panning operation. You can select Surge, Sag or both. 
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Placing a check in the Zoom parent frame when panning will enable automatic zooming of the 
parent graph when stepping through exceedence events. 

See Also 

14.31 Exceedence Statistics Frame  
14.6 Tabs dialog box  

14.34 Exceedence List Frame 
The Exceedence List frame is a child frame linked to either a Channel Graph of Micro-Graph 
frame.  The Exceedence List frame displays a textual list of the exceedence records in the 
database attached to its parent frame.  You can customize the text displayed using the 
Exceedence List Properties dialog box.  The displayed text is obtained from the exceedence 
records in the recorded data contained within the parent frame. 

You can step between exceedence list entries. Selecting Pan To Start displays the first 
exceedence event. Selecting Pan To End displays the last captured exceedence event. Selecting 
the Step Right or Step Left displays the next or previously captured event. 

When stepping through the captured exceedence events, the selection will move from each 
exceedence for the channel associated with the currently displayed event. After the last event for 
the current channel, the first (or last depending on direction of stepping) event for the next (or 
previous) channel will be displayed. 

In addition to stepping through the list with the tool bar, you can select a specific event listed 
using the mouse pointer. The text for the selected event will be highlighted, indicating which event 
in the list is currently selected. 

Enabling Zoom parent frame on selection (see Exceedence List Properties dialog box) will 
cause the parent graph to zoom to the time period associated with the newly selected event.  If 
the parent frame is a Micro-Graph then the auto zooming function will result in the Micro-Graphs 
frames parent being updated (gray area) to display the relative time and location of the selected 
waveform. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.34 Exceedence List Properties dialog box 

14.35 Exceedence List Properties dialog box 
Format Page 

The Exceedence List Properties dialog box allows you to specify what is displayed in its 
associated Exceedence List Frame. This page of the dialog box allows you to select the type of 
exceedence to filter when building the exceedence list. You can select Surge, Sag or both. 

You can also specify the sort order when displaying the exceedence events. To change the sort 
order, select an item in the Sort Order list and select the Prompt or Demote button. Entries higher 
in the list will have a higher priority. Entries lower in the list will have a lower priority. 

The list can be displayed (sorted) in either descending or ascending order. This primary order is 
specified via the radio buttons in the Sort Type radio group. 

You can also limit the number of entries displayed in the list by entering a value in the List size 
limit dialog field. 
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Scrolling 

Enable scrolling: placing a check next to this option causes the frame to only display the 
specified number of lines.  Scroll bars are displayed along the right side of the frame to 
move through the list. 

Window size: specifies the maximum number of lines to be display in the frame for 
scrolling. 

Placing a check in the Zoom parent frame on selection will enable automatic zooming of the 
parent graph when stepping through or selecting exceedence events. 

Parameters Page 

The actual parameters displayed are selected on the dialog’s second properties page.  This page 
of the dialog box contains a list of available parameters and a list of selected parameters. The 
entries in the Selected parameters list are the items displayed on each line of the list. A 
parameter is added to the Selected parameters list by highlighting the desired parameter in the 
Available parameter list and pressing the Add>> button. Parameters are removed from the 
Selected parameter list by selecting the desired entry and pressing the <<Remove button. 

Parameters can be moved up or down in the Selected parameters list by selecting the desired 
entry and pressing the Promote or Demote buttons. Parameters higher in the list are displayed 
before entries lower in the list. Promoting an entry moves it closer to the start of the displayed 
line. Demoting and entry moves it closer to the end of the displayed line. 

The width of each column (parameter entry) can be automatically adjusted or you can specify a 
fixed with.  To have the width of all columns automatically adjusted place a check next to the 
Auto Width option.  If you want to specify a fixed column width remove the check from the Auto 
Width option.  Then select the each selected parameter and specify a width in the Field Width 
edit box.  The Field Width edit box sets the width for the selected parameter.  You must select 
each parameter in turn to set its associated column width. 

Selecting a parameter and then specifying the desired alignment can specify the horizontal 
alignment of each parameter.  Each parameter has its own associated alignment.  You must 
select each parameter in turn to change their associated column alignment. 

A box can be drawn around the resulting list table by placing a check next to the Draw box 
around frame option.  Removing the check from this option prevents the box for being drawn. 

A grid can be drawn between each column and row of the table by placing a check next to the 
Draw grid option.  Removing the check from this option prevents the grid from being drawn. 

You can disable the relative highlighting of a parent graph by placing a check next to the Disable 
relative highlight of parent frame option.  When not checked the parent graph will highlight the 
region of the graph corresponding to the start time and duration of the selected list entry. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

The Make Default button allows you to save the currently selected parameter list for future recall. 
Selecting the Make Default button saves the currently selected parameters, tab positions and 
text font into the Windows registry. 

The Load Default button allows you to recall a previously saved parameter list, tab positions and 
text font. 

Only a single default configuration can be saved at one time. Selecting the Make Default button 
over writes the previous default configuration. 

See Also 

14.33 Exceedence List Frame  
14.6 Tabs dialog box  
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14.36 Exception List Frame 
The Exception List frame is a child frame linked to either a Channel Graph of Micro-Graph frame.  
The Exception List frame displays a textual list summary of the sample points for a given channel, 
which exceed user-specified thresholds.  You can customize the text displayed using the 
Exception List Properties dialog box.  The displayed text is obtained from the exceedence records 
in the recorded data contained within the parent frame. 

You can step between exception list entries. Selecting Pan To Start displays the first exception 
entry. Selecting Pan To End displays the last exception entry. Selecting the Step Right or Step 
Left displays the next or previous list entry. 

When stepping through the captured exception entries the selection will move from each 
exception for the associated channel. 

In addition to stepping through the list with the tool bar, you can select a specific entry listed using 
the mouse pointer. The text for the selected entry will be highlighted, indicating which entry in the 
list is currently selected. 

Enabling Zoom parent frame on selection (see Exception List Properties dialog box) will cause 
the parent graph to zoom to the time period associated with the newly selected entry.  If the 
parent frame is a Micro-Graph, then the auto zooming function will result in the Micro-Graphs 
frames parent being updated (gray area) to display the relative time and location of the selected 
waveform. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.36 Exception List Properties dialog box  

14.37 Exception List Properties dialog box 
The Exception List Properties dialog box allows you to specify what is displayed in its associated 
Exception List frame. 

Format Page 

This page of the dialog box allows you to specify the channel and limits to be used in creating the 
exception report. The items in this dialog box are defined as follows: 

Database: Indicates the name of the database containing the recorded channel data. It is 
available for information only and is obtained from the parent trend graph. 

Selected trace: When selected, the exception report will be generated for the trace selected in 
the parent frame. When another trace is selected in the parent frame, the exception report will be 
updated to reflect the measurements of the newly selected trace. 

Available channels: A list of the channels contained in the parent graphs database. Select the 
channel to be used in the exception report. Only a single channel can be selected at one time. 
While Selected trace is checked you will not be able to select an entry in this list. 

Show all: A check box, which acts as a filter mechanism. When checked, all the recorded 
channels contained within the parents database are displayed. When not checked, only the 
channels, which have been selected for display in the parent graph are displayed. While 
Selected trace is checked, this option is disabled and you will not be able to select this item. 

Lock frame data: When checked, the displayed exception report becomes static. Changes to the 
parent frame do not affect the exception report. When not checked, changes to the parent frame 
(as will be described shortly) affect the exception report. 

Limit list to parent display frame: When checked, the exception report is limited to the zoomed 
section of the parent graph frame. When not checked, the entire time frame of the recorded 
channel is included in the exception report. 
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Zoom parent frame on selection: When checked, the parent graph is automatically zoomed to 
the time period associated with the newly selected entry. If the parent frame is a Micro-Graph, 
then the auto zooming function will result in the Micro-Graph frame’s parent being updated (gray 
area) to display the relative time and location of the selected list entry. 

Exception filter: A set of radio buttons that define how the specified limits are to be used. They 
are defined as follows: 

• Above upper limit: When selected, only the upper limit is used. The lower limit edit box is 
disabled and grayed. If the Inclusive check box is selected, the exception report includes 
measurements equal to and above the upper limit. When the Inclusive check box is not 
selected, the exception report includes only values above the upper limit. 

• Below lower limit: When selected, only the lower limit is used. The upper limit edit box is 
disabled and grayed. If the Inclusive check box is selected, the exception report includes 
measurements equal to and below the lower limit. When the Inclusive check box is not 
selected, the exception report includes only values below the lower limit. 

• Within upper and lower limits: When selected, both the upper and lower limit edit boxes are 
enabled. If the Inclusive check box is selected, the exception report includes measurements 
that are equal to or greater than the lower limit and lower than or equal to the upper limit. 
When the Inclusive check box is not selected, only values that are greater than the lower limit 
and less than the upper limit are included. 

• Outside upper and lower limits: When selected, both the upper and lower limit edit boxes 
are enabled. If the Inclusive check box is selected, the exception report includes 
measurements that are equal to the lower limit, or less than the lower limit, or equal to the 
upper limit, or greater than the upper limit. When the Inclusive check box is not selected, only 
values that are less than the lower limit or greater than the upper limit are included. 

Inclusive: When checked, the exception report includes the specified limits. When not checked, 
the exception report does not include the limit values. See Exception type above for more. 

Get limits from database: Some instruments (such as the PowerPad) specify upper and lower 
exception limits when the database is created.  When this option is checked and the limits are 
specified in the database then those limits will be used.  If the limits are not specified in the 
database then the limits specified here will be used.  When not checked only the limits specified 
here will be used even if they are specified in the database. 

Upper limit: Specifies the upper limit of the exception report. See Exception type above for more. 

Lower limit: Specifies the lower limit of the exception report. See Exception type above for more. 

Display limit bands: placing a check next to this option causes horizontal lines at the specified 
limit ranges to be displayed on the parent graph. 

Limit color: specifies the color of the limit bars to be displayed on the parent graph. 

Scrolling 

Enable scrolling: placing a check next to this option causes the frame to only display the 
specified number of lines.  Scroll bars are displayed along the right side of the frame to 
move through the list. 

Window size: specifies the maximum number of lines to be display in the frame for 
scrolling. 

When the Limit list to parent display frame check box is selected, any change to the zoomed 
state of the parent graph window will result in the exception report being updated for the selected 
time frame. 
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By combining the Limit list to parent display frame and Selected trace options, the exception 
report will become dynamic. The associated channel and time frame are updated as you interact 
with the parent frame graph. 

Placing a check next to Lock frame data, results in the exception report becoming static. The 
dynamic nature of the report is disabled when the Lock frame data option is checked. 

Parameters Page 

The actual parameters displayed are selected on the dialog’s second properties page.  This page 
of the dialog box contains a list of available parameters and a list of selected parameters. The 
entries in the Selected parameters list are the items displayed on each line of the list. A 
parameter is added to the Selected parameters list by highlighting the desired parameter in the 
Available parameter list and pressing the Add>> button. Parameters are removed from the 
Selected parameter list by selecting the desired entry and pressing the <<Remove button. 

Parameters can be moved up or down in the Selected parameters list by selecting the desired 
entry and pressing the Promote or Demote buttons. Parameters higher in the list are displayed 
before entries lower in the list. Promoting an entry moves it closer to the start of the displayed 
line. Demoting and entry moves it closer to the end of the displayed line. 

The width of each column (parameter entry) can be automatically adjusted or you can specify a 
fixed with.  To have the width of all columns automatically adjusted place a check next to the 
Auto Width option.  If you want to specify a fixed column width remove the check from the Auto 
Width option.  Then select the each selected parameter and specify a width in the Field Width 
edit box.  The Field Width edit box sets the width for the selected parameter.  You must select 
each parameter in turn to set its associated column width. 

Selecting a parameter and then specifying the desired alignment can specify the horizontal 
alignment of each parameter.  Each parameter has its own associated alignment.  You must 
select each parameter in turn to change their associated column alignment. 

A box can be drawn around the resulting list table by placing a check next to the Draw box 
around frame option.  Removing the check from this option prevents the box for being drawn. 

A grid can be drawn between each column and row of the table by placing a check next to the 
Draw grid option.  Removing the check from this option prevents the grid from being drawn. 

You can disable the relative highlighting of a parent graph by placing a check next to the Disable 
relative highlight of parent frame option.  When not checked the parent graph will highlight the 
region of the graph corresponding to the start time and duration of the selected list entry. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

The Make Default button allows you to save the currently selected parameter list for future recall. 
Selecting the Make Default button saves the currently selected parameters, tab positions and 
text font into the Windows registry. 

The Load Default button allows you to recall a previously saved parameter list, tab positions and 
text font. 

Only a single default configuration can be saved at one time. Selecting the Make Default button 
over writes the previous default configuration. 

See Also 

14.35 Exception List Frame  

14.38 Trend Summary List Frame 
The Trend Summary List frame is a child frame linked to either a Channel Graph of Micro-Graph 
frame.  The Trend Summary List frame displays a textual list summary of the sample points for a 
given channel.  Each summary line contains the minimum, maximum and average values of a 
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group of sample points.  You can specify the number of samples to be summarized, as well as, 
customize the text displayed using the Trend Summary List Properties dialog box.  The displayed 
text is obtained from the combined sample points in the recorded data contained within the parent 
frame. 

You can step between list entries. Selecting Pan To Start displays the first list entry. Selecting 
Pan To End displays the last list entry. Selecting the Step Right or Step Left displays the next or 
previous list entry. 

When stepping through the captured list entries, the selection will move from each entry for the 
associated channel. 

In addition to stepping through the list with the tool bar, you can select a specific entry listed using 
the mouse pointer. The text for the selected entry will be highlighted, indicating which entry in the 
list is currently selected. 

Enabling Zoom parent frame on selection (see Trend Summary List Properties dialog box) will 
cause the parent graph to zoom to the time period associated with the newly selected entry.  If 
the parent frame is a Micro-Graph, then the auto zooming function will result in the Micro-Graph 
frame’s parent being updated (gray area) to display the relative time and location of the selected 
waveform. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.38 Trend Summary List Properties dialog box  

14.39 Trend Summary List Properties dialog box 
Format Page 

The Trend Summary List Properties Dialog Box allows you to specify what is displayed in its 
associated Trend Summary List frame. This page of the dialog box allows you to specify the 
summary options available for the Trend Summary report. The items in this dialog box are 
defined as follows: 

Database: Indicates the name of the database containing the recorded channel data. It is 
available for information only and is obtained from the parent trend graph. 

Selected trace: When enabled, the trend summary report will be generated for the trace selected 
in the parent frame. When another trace is selected in the parent frame, the report will be updated 
to reflect the measurements of the newly selected trace. 

Show all: A check box, which acts as a filter mechanism. When checked, all the recorded 
channels contained within the parent’s database are displayed. When not checked, only the 
channels that have been selected for display in the parent graph are displayed. While Selected 
trace is checked, this option is disabled and you will not be able to select this item. 

Available channels: A list of the channels contained in the parent graph’s database. Select the 
channel to be used in the trend summary report. Only a single channel can be selected at one 
time. While Selected trace is checked, you will not be able to select an entry in this list. 

Lock frame data: When checked, the displayed trend summary report becomes static. Changes 
to the parent frame do not affect the trend summary report. When not checked, changes to the 
parent frame (as will be described shortly) affect the trend summary report. 

Zoom parent frame on selection: When checked, the parent graph is automatically zoomed to 
the time period associated with the newly selected entry. If the parent frame is a Micro-Graph, 
then the auto zooming function will result in the Micro-Graph frame’s parent being updated (gray 
area) to display the relative time and location of the selected list entry. 
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Limit summary to parent window: When checked, the trend summary report is limited to the 
zoomed section of the parent graph frame. When not checked, the entire time frame of the 
recorded channel is included in the trend summary report. 

Summary Type: A set of radio buttons, which define how the sample points are to be combined 
when generating the report. They are defined as follows: 

• Average by sample count: When selected, the value contained in the associated edit box is 
used to indicate the number of samples that are combined for each list entry. For example, if 
this option is selected and the edit box contains 10, every 10 samples will be compared for 
the minimum and maximum values to display in a list entry. Also, the 10 samples will be 
averaged for each list entry. 

• Average by sample period: When selected, the time period contained in the associated 
drop down list is used to indicate the number of samples that are combined for each list entry. 
The actual number of samples combined will depend on the storage rate of the recorded 
data. For example, if the recorded data were stored at 1-second intervals and a 1-minute 
averaging is selected, 60 samples will be combined for each summary list entry. 

Scrolling 

Enable scrolling: placing a check next to this option causes the frame to only display the 
specified number of lines.  Scroll bars are displayed along the right side of the frame to 
move through the list. 

Window size: specifies the maximum number of lines to be display in the frame for 
scrolling. 

When the Limit summary to parent window check box is selected, any change to the zoomed 
state of the parent graph window will result in the trend summary report being updated for the 
selected time frame. By combining the Limit summary to parent window and Selected trace 
options, the trend summary report becomes dynamic. The associated channel and time frame of 
the summary list are updated as you interact with the parent frame graph. Placing a check next to 
Lock frame data results in the exception report becoming static. The dynamic nature of the 
report is disabled when the Lock frame data option is checked. 

Parameters Page 

The actual parameters displayed are selected on the dialog’s second properties page.  This page 
of the dialog box contains a list of available parameters and a list of selected parameters. The 
entries in the Selected parameters list are the items displayed on each line of the list. A 
parameter is added to the Selected parameters list by highlighting the desired parameter in the 
Available parameter list and pressing the Add>> button. Parameters are removed from the 
Selected parameter list by selecting the desired entry and pressing the <<Remove button. 

Parameters can be moved up or down in the Selected parameters list by selecting the desired 
entry and pressing the Promote or Demote buttons. Parameters higher in the list are displayed 
before entries lower in the list. Promoting an entry moves it closer to the start of the displayed 
line. Demoting and entry moves it closer to the end of the displayed line. 

The width of each column (parameter entry) can be automatically adjusted or you can specify a 
fixed with.  To have the width of all columns automatically adjusted place a check next to the 
Auto Width option.  If you want to specify a fixed column width remove the check from the Auto 
Width option.  Then select the each selected parameter and specify a width in the Field Width 
edit box.  The Field Width edit box sets the width for the selected parameter.  You must select 
each parameter in turn to set its associated column width. 

Selecting a parameter and then specifying the desired alignment can specify the horizontal 
alignment of each parameter.  Each parameter has its own associated alignment.  You must 
select each parameter in turn to change their associated column alignment. 
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A box can be drawn around the resulting list table by placing a check next to the Draw box 
around frame option.  Removing the check from this option prevents the box for being drawn. 

A grid can be drawn between each column and row of the table by placing a check next to the 
Draw grid option.  Removing the check from this option prevents the grid from being drawn. 

You can disable the relative highlighting of a parent graph by placing a check next to the Disable 
relative highlight of parent frame option.  When not checked the parent graph will highlight the 
region of the graph corresponding to the start time and duration of the selected list entry. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

The Make Default button allows you to save the currently selected parameter list for future recall. 
Selecting the Make Default button saves the currently selected parameters, tab positions and 
text font into the Windows registry. 

The Load Default button allows you to recall a previously saved parameter list, tab positions and 
text font. 

Only a single default configuration can be saved at one time. Selecting the Make Default button 
over writes the previous default configuration. 

See Also 

14.37 Trend Summary List Frame  

14.40 Channel List Frame 
The Channel List frame can be used independently or as a child frame linked to a Channel Graph 
frame.  The Channel List frame displays a textual list of records for a specified list of channels. 

When used independently you specify the database to be loaded.  When created independently 
you can link other frames to it just as if it were a Graph frame. 

Enabling Zoom parent frame on selection will cause the parent graph to zoom to the time 
period associated with the newly selected channel record entry. 

Enabling Force display of trace will cause the trace for the selected channel record to be 
enabled for display in the parent frame even if it was not already.  This has the effect of forcing 
the display of a channel record even if previously disabled. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.40 Channel List Properties dialog box  
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14.41 Channel List Properties dialog box 
The Channel List Properties dialog box allows you to specify what is displayed in its associated 
list frame. 

Channel List Page 

The first page of the Channel List Properties dialog box is illustrated in the following figure. 

 
This page of the dialog box allows you to specify the summary options available for the Channel 
List report frame. The items in this dialog box are defined as follows: 

Database: Indicates the name of the database containing the recorded channel data. It is 
available for information only and is obtained from the parent trend graph. 

Force display of trace: When selected, the trace for the selected channel record will be enabled 
for display in the parent frame even if it was not already.  This has the effect of forcing the display 
of a channel record even if previously disabled. 

Zoom parent frame on selection: When checked, the parent graph is automatically zoomed to 
the time period associated with the newly selected entry. 

Available channels: A list of the channels contained in the parent graph’s database. Select the 
channel(s) to be used in the channel list report frame. One or more channels can be selected.  To 
select more than one entry press and hold down the CTRL key while right clicking a list entry. 

Select All: When selecting this button all entries in the Available channels list will be selected for 
inclusion in the list frame. 

Deselect All: When selecting this button all entries in the Available channels list will be 
deselected for inclusion in the list frame. 
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Scrolling 

Enable scrolling: placing a check next to this option causes the frame to only display the 
specified number of lines.  Scroll bars are displayed along the right side of the frame to 
move through the list. 

Window size: specifies the maximum number of lines to be display in the frame for 
scrolling. 

Template Filter: Allows you to specify how channels should be included when this view is saved 
and used as a template to open other databases.  The options available are 

• Channel Type Only: when selected any channel of the same type (for example 
voltage waveforms) as those currently selected for display will be automatically 
included for display regardless of the channels code and modifier. 

• Channel Type and Code: when selected any channel of the same type and with the 
same measurement code will be automatically included for display regardless of the 
channels modifier. 

• Channel Type, Code and Modifier: when selected only channels with the same data 
type, same measurement code and same measurement modifier will be automatically 
included for display. 

Delete page this list is on when opening as a template and the list is empty: this option 
allows empty pages to be deleted automatically when creating a view from a template.  For 
example if we add a page that contains a channel list for a specific channel type we can have the 
page deleted automatically if a database that does not contain this channel type is opened using 
this template.  The page become optional and only added to the view if the list is not empty. 
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Parameters Page 

The actual parameters displayed are selected on the dialog’s second properties page. This page 
is illustrated in the following figure. 

 
This page of the dialog box contains a list of available parameters and a list of selected 
parameters. The entries in the Selected parameter list are the items displayed on each line of the 
list. A parameter is added to the Selected parameters list by highlighting the desired parameter in 
the Available parameter list and pressing the Add>> button. Parameters are removed from the 
Selected parameter list by selecting the desired entry and pressing the <<Remove button. 

Parameters can be moved up or down in the Selected parameters list by selecting the desired 
entry and pressing the Promote or Demote buttons. Parameters higher in the list are displayed 
before entries lower in the list. Promoting an entry moves it closer to the start of the displayed 
line. Demoting and entry moves it closer to the end of the displayed line. 

The width of each column (parameter entry) can be automatically adjusted or you can specify a 
fixed with.  To have the width of all columns automatically adjusted place a check next to the 
Auto Width option.  If you want to specify a fixed column width remove the check from the Auto 
Width option.  Then select the each selected parameter and specify a width in the Field Width 
edit box.  The Field Width edit box sets the width for the selected parameter.  You must select 
each parameter in turn to set its associated column width. 

Selecting a parameter and then specifying the desired alignment can specify the horizontal 
alignment of each parameter.  Each parameter has its own associated alignment.  You must 
select each parameter in turn to change their associated column alignment. 

A box can be drawn around the resulting list table by placing a check next to the Draw box 
around frame option.  Removing the check from this option prevents the box for being drawn. 
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A grid can be drawn between each column and row of the table by placing a check next to the 
Draw grid option.  Removing the check from this option prevents the grid from being drawn. 

You can disable the relative highlighting of a parent graph by placing a check next to the Disable 
relative highlight of parent frame option.  When not checked the parent graph will highlight the 
region of the graph corresponding to the start time and duration of the selected list entry. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

The Make Default button allows you to save the currently selected parameter list for future recall. 
Selecting the Make Default button saves the currently selected parameters, tab positions and 
text font into the Windows registry. 

The Load Default button allows you to recall a previously saved parameter list, tab positions and 
text font. 

Only a single default configuration can be saved at one time. Selecting the Make Default button 
over writes the previous default configuration. 

See Also 

14.39 Channel List Frame 

14.42 Channel Summary Frame 
The Channel Summary frame is a child frame linked to a Channel Graph frame.  The Channel 
Information frame has replaced the Channel Summary frame.  The Channel Summary frame is 
available for older templates and views that use it. 

The Channel Summary frame displays a textual summary of the channel record trace selected in 
its parent frame.  You can customize the text displayed using the Channel Summary Properties 
dialog box.  The displayed text is obtained from the trace selected in the parent frame. 

The Channel Summary frame contains static and dynamic text. Static text is displayed as it was 
typed into the Channel Summary Properties dialog box. Dynamic text is generated through field 
substitution. The value obtained from the parent frame of the specified field is substituted for the 
field name. 

Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. 
For example, if the Exceedence Type field of the selected exceedence trace is Sag, placing the 
text [Exceedence Type] in the Exceedence Statistics Text edit box will result in Sag being 
displayed in its place on the page. 

Dynamic text substitution is useful for templates that create a view when recorded data is 
attached to it. The field name will reflect the name contained in the attached database, which may 
be different from database to database. 

See Also 

13.2 Graph Frame  
14.21 Creating a Linked Frame  
14.42 Channel Summary Properties dialog box  
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14.43 Channel Summary Properties dialog box 
The Channel Summary Properties dialog box allows you to specify what type of channel record 
and what is displayed in its associated Channel Summary frame. The first page of the Channel 
Summary Properties dialog box is illustrated in the following figure. 

 
This page of the dialog box contains a set of radio buttons that allow you to define what type of 
channel records this frame should display a summary for. 
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The text to be displayed is specified in the second page of this dialog box.  This page is illustrated 
in the following figure: 

 
This page of the dialog box contains an edit box into which you type the static and dynamic text to 
be displayed in the Channel Summary frame. It also contains a list box from which you can select 
field names, field values and field codes. 

Static text is displayed as it is typed into the Text edit box. Dynamic text is generated through field 
substitution. The value of the specified field as obtained from the Channel Summary frame’s 
parent is substituted for the field name. 

Surrounding the field name with square brackets, specifies dynamic text. For example, if the DAR 
field of the selected megohmmeter test measurement trace is 1.000, placing the text [DAR] in the 
Channel Summary Text edit box will result in 1.000 being displayed in its place on the page. 

Dynamic text substitution is useful for templates, which create a view when session data is 
attached to it. The field name will reflect the name contained in the attached database, which may 
be different from database to database. 

Channel Summary fields can be added to the Text edit box in a number of ways. First, place the 
cursor in the Text edit box were the Channel Summary field is to be inserted. Next, click on the 
Channel Summary field (in the list box) to be inserted. The next step depends on what you want 
inserted. To insert the field name as static text, click on the Insert Field Name button (notice 
brackets are not placed around the field name). To insert the field value as static text, click on the 
Insert Field Value button (notice that the value displayed in the list box is inserted). To insert the 
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field value as dynamic text, click on the Insert Field Code button (notice that the name of the 
field surrounded by square brackets is inserted). 

If the selected Field does not have a current value associated with it the Insert Field Value 
button will be grayed and unavailable. 

As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will 
position the cursor to the next tab position. You can change the default tab positions by selecting 
the Tabs button. This will display the Tabs dialog box. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

See Also 

14.41 Channel Summary Frame  
14.6 Tabs dialog box  

14.44 Channel Information Frame 
The Channel Information frame is a child frame linked to a Channel Graph frame.  The Channel 
Information frame displays a textual summary of the channel record trace selected in its parent 
frame.  You can customize the text displayed using the Channel Summary Properties dialog box.  
The displayed text is obtained from the trace selected in the parent frame. 

The Channel Information frame contains static and dynamic text. Static text is displayed as it was 
typed into the Channel Summary Properties dialog box. Dynamic text is generated through field 
substitution. The value obtained from the parent frame of the specified field is substituted for the 
field name. 

Surrounding the exceedence statistics field name with square brackets, specifies dynamic text. 
For example, if the Exceedence Type field of the selected exceedence trace is Sag, placing the 
text [Exceedence Type] in the Exceedence Statistics Text edit box will result in Sag being 
displayed in its place on the page. 

Dynamic text substitution is useful for templates that create a view when recorded data is 
attached to it. The field name will reflect the name contained in the attached database, which may 
be different from database to database. 
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14.45 Channel Information Properties dialog box 
The Channel Information Properties dialog box allows you to specify what type of channel record 
and what is displayed in its associated Channel Information frame. The first page of the Channel 
Information Properties dialog box is illustrated in the following figure. 

 
This page of the dialog box contains a list of channel measurement types.  Each measurement 
type has its own substitution text.  You first select the channel type then select the Text dialog tab 
and specify the associated text. 
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The text to be displayed for the selected channel type is specified in the second page of this 
dialog box.  This page is illustrated in the following figure: 

 
This page of the dialog box contains an edit box into which you type the static and dynamic text to 
be displayed in the Channel Summary frame. It also contains a list box from which you can select 
field names, field values and field codes. 

Static text is displayed as it is typed into the Text edit box. Dynamic text is generated through field 
substitution. The value of the specified field as obtained from the Channel Summary frame’s 
parent is substituted for the field name. 

Surrounding the field name with square brackets, specifies dynamic text. For example, if the DAR 
field of the selected megohmmeter test measurement trace is 1.000, placing the text [DAR] in the 
Channel Summary Text edit box will result in 1.000 being displayed in its place on the page. 

Dynamic text substitution is useful for templates, which create a view when session data is 
attached to it. The field name will reflect the name contained in the attached database, which may 
be different from database to database. 

Channel fields can be added to the Text edit box in a number of ways. First, place the cursor in 
the Text edit box were the Channel field is to be inserted. Next, click on the Channel field (in the 
list box) to be inserted. The next step depends on what you want inserted. To insert the field 
name as static text, click on the Insert Field Name button (notice brackets are not placed around 
the field name). To insert the field value as static text, click on the Insert Field Value button 
(notice that the value displayed in the list box is inserted). To insert the field value as dynamic 
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text, click on the Insert Field Code button (notice that the name of the field surrounded by square 
brackets is inserted). 

If the selected Field does not have a current value associated with it the Insert Field Value 
button will be grayed and unavailable. 

As in any text editor, pressing the Enter key will create a new line. Pressing the Tab key will 
position the cursor to the next tab position. You can change the default tab positions by selecting 
the Tabs button. This will display the Tabs dialog box. 

You can also change the font used to display this text by clicking on the Font button and 
specifying the font attributes. 

14.46 Histogram Frame 
A Histogram frame displays a bar chart of selected channels.  As with graph frames you can 
customize the channels that are displayed and the colors of those channels.  The channels are 
automatically grouped when displayed.  The Histogram frame allows the following frames to be 
linked to it 

• Channel Information: displays information about the selected bar 

• Graph Legend: displays a legend for the bars being displayed. 

• Session Summary: display summary information about the recording session. 

A bar can be selected by positioning the mouse pointer over the desired bar and clicking the left 
mouse button.  If a Channel Information frame is linked it will be updated to display information 
about the selected bar. 

14.47 Histogram Properties dialog box 
This dialog box consists of two pages.  The first (Channels) page allows you to select the 
channels to be displayed in the trend graph frame. 

Channels dialog page 

Select a channel to be displayed by highlighting it (left clicking the mouse pointer on it) in the 
Available channels list, then click on the Add>> button. The selected channel will be added to 
the Selected channels list. You can remove channels from the selected channel list by 
highlighting it and clicking on the <<Remove button. You can add all of the available channels to 
the selected channels list by clicking on the Add All>> button. You can also remove all channels 
from the selected channel list by clicking on the <<Remove All button. 

You can change the color used to draw each of the channels by highlighting its entry in the 
selected channel list and selecting an alternate color from the Line color drop down list. You can 
also specify a color, other than one in the color list, by specifying the amount of each color 
component in the Red, Green and Blue fields. In addition, you can use the color picker to select 
from a wider range of colors. 

The color picker is displayed by clicking on the color palette icon . A color picker dialog will be 
displayed. 
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Template Filter: Allows you to specify how channels should be included when this view is saved 
and used as a template to open other databases.  The options available are 

• Channel Type Only: when selected any channel of the same type (for example 
voltage waveforms) as those currently selected for display will be automatically 
included for display regardless of the channels code and modifier. 

• Channel Type and Code: when selected any channel of the same type and with the 
same measurement code will be automatically included for display regardless of the 
channels modifier. 

• Channel Type, Code and Modifier: when selected only channels with the same data 
type, same measurement code and same measurement modifier will be automatically 
included for display. 

Delete frame if selected channel list is empty when opening via a template: this option 
allows you to mark the frame (and all of the attached child frames) for deletion if the Selected 
channels list is empty after opening a database when this view is used as a template.  Placing a 
check next to this option marks the frame for deletion if empty.  When not checked the frame will 
not be deleted even if the database does not contain and similar channels (as defined by the 
Template Filter option). 

Scales dialog page 

The second (Scales) page of this dialog box allows you to specify how the vertical scales of the 
associated graph are to be drawn. 

Placing a check next to Automatically adjust vertical scale maximum instructs DataViewer® to 
automatically adjust the upper end of the vertical scale to accommodate the displayed channels.  
Removing the check from this option causes the upper limit of the vertical scale to be fixed at the 
specified value. 

Placing a check next to Enable lower limit for vertical scale maximum allows you to specify a 
value for which the upper end of the vertical scale is not allowed to go below. 

Placing a check next to Automatically adjust vertical scale minimum instructs DataViewer® to 
automatically adjust the lower end of the vertical scale to accommodate the displayed channels.  
Removing the check from this option causes the lower limit of the vertical scale to be fixed at the 
specified value. 

Placing a check next to Display channel units on graph causes the units for each channel 
selected for display to be displayed on the left side of the graph.  When this option is selected you 
can also over-ride the default channel units and display other text as units. 

When Display channel units on graph is selected you can check Display channel 
units as.  Doing so allows you to enter any text you would like displayed for the vertical 
scale units in the edit box to the right. 

Placing a check next to Display upper threshold limit bar allows you to draw a horizontal line at 
the specified limit level and color.  The limit bar is drawn for reference only and is not used to 
analyze the selected channels. 

Placing a check next to Display lower threshold limit bar allows you to draw a horizontal line at 
the specified limit level and color.  The limit bar is drawn for reference only and is not used to 
analyze the selected channels. 

Once the desired properties for this new Graph frame are specified, select the OK button. The 
frame will be created using the specified properties. 
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14.48 Bar Chart Meter 
A Bar Chart Meter frame displays individual sample points for a selected point on a graph in bar 
chart format.  As with graph frames you can customize the channels that are displayed and the 
colors of those channels.  The channels are automatically grouped when displayed.  The Bar 
Chart Meter frame allows the following frames to be linked to it 

• Channel Information: displays information about the selected bar 

• Graph Legend: displays a legend for the bars being displayed. 

• Session Summary: display summary information about the recording session. 

A bar can be selected by positioning the mouse pointer over the desired bar and clicking the left 
mouse button.  If a Channel Information frame is linked it will be updated to display information 
about the selected bar. 

14.49 Bar Chart Meter Properties dialog box 
This dialog box consists of two pages.  The first (Channels) page allows you to select the 
channels to be displayed in the trend graph frame. 

Channels dialog page 

Select a channel to be displayed by highlighting it (left clicking the mouse pointer on it) in the 
Available channels list, then click on the Add>> button. The selected channel will be added to 
the Selected channels list. You can remove channels from the selected channel list by 
highlighting it and clicking on the <<Remove button. You can add all of the available channels to 
the selected channels list by clicking on the Add All>> button. You can also remove all channels 
from the selected channel list by clicking on the <<Remove All button. 

You can change the color used to draw each of the channels by highlighting its entry in the 
selected channel list and selecting an alternate color from the Line color drop down list. You can 
also specify a color, other than one in the color list, by specifying the amount of each color 
component in the Red, Green and Blue fields. In addition, you can use the color picker to select 
from a wider range of colors. 

The color picker is displayed by clicking on the color palette icon . A color picker dialog will be 
displayed. 

Template Filter: Allows you to specify how channels should be included when this view is saved 
and used as a template to open other databases.  The options available are 

• Channel Type Only: when selected any channel of the same type (for example 
voltage waveforms) as those currently selected for display will be automatically 
included for display regardless of the channels code and modifier. 

• Channel Type and Code: when selected any channel of the same type and with the 
same measurement code will be automatically included for display regardless of the 
channels modifier. 

• Channel Type, Code and Modifier: when selected only channels with the same data 
type, same measurement code and same measurement modifier will be automatically 
included for display. 

Delete frame if selected channel list is empty when opening via a template: this option 
allows you to mark the frame (and all of the attached child frames) for deletion if the Selected 
channels list is empty after opening a database when this view is used as a template.  Placing a 
check next to this option marks the frame for deletion if empty.  When not checked the frame will 
not be deleted even if the database does not contain and similar channels (as defined by the 
Template Filter option). 
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Scales dialog page 

The second (Scales) page of this dialog box allows you to specify how the vertical scales of the 
associated graph are to be drawn. 

Placing a check next to Automatically adjust vertical scale maximum instructs DataViewer® to 
automatically adjust the upper end of the vertical scale to accommodate the displayed channels.  
Removing the check from this option causes the upper limit of the vertical scale to be fixed at the 
specified value. 

Placing a check next to Enable lower limit for vertical scale maximum allows you to specify a 
value for which the upper end of the vertical scale is not allowed to go below. 

Placing a check next to Automatically adjust vertical scale minimum instructs DataViewer® to 
automatically adjust the lower end of the vertical scale to accommodate the displayed channels.  
Removing the check from this option causes the lower limit of the vertical scale to be fixed at the 
specified value. 

Placing a check next to Display upper threshold limit bar allows you to draw a horizontal line at 
the specified limit level and color.  The limit bar is drawn for reference only and is not used to 
analyze the selected channels. 

Placing a check next to Display lower threshold limit bar allows you to draw a horizontal line at 
the specified limit level and color.  The limit bar is drawn for reference only and is not used to 
analyze the selected channels. 

Once the desired properties for this new Graph frame are specified, select the OK button. The 
frame will be created using the specified properties. 
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CHAPTER 15: WORKING WITH FRAMES 

15.1 Modifying  a Frame 
Professional Version  

Once a frame is created it can be moved, resized, cut, copied and pasted on the page. In 
addition, its associated properties can be modified. 

See Also 

15.2 Selecting a Frame  15.3 Cutting, Copying, and Pasting Frames  
15.4 Cutting a Frame  15.5 Copying a Frame  
15.6 Pasting a Frame  15.8 Copying a Frame to Another Page  
15.7 Moving a Frame to Another Page  

15.2 Selecting a Frame 

To select a frame for modification, use the Select Frame  tool, then select the desired frame 
by placing the mouse pointer over it and clicking the left mouse button. Resize handles will be 
displayed around the selected frame. Figure 20 shows a Graph frame that has been selected. 

 
The graph frame has been selected and has the resize handles displayed. The resize handles 
are located in each of the four corners and at the middle of each of the four sides. When the 
mouse pointer is over a resize handle, the pointer changes to a resize arrow indicating the 
direction that handle will resize the frame in. To resize the frame, click on and drag the resize 
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handle in the required direction. Dragging the upper left handle leaves the lower right corner of 
the frame anchored and allows you to move the upper left corner of the frame. Each of the 
remaining corners allow you to move it leaving the corner diagonal to it fixed. Dragging one of the 
resize handles located in the middle of a side moves the corresponding side only, leaving the 
corners for the other side fixed. 

Clicking and dragging in the center of the frame will move the frame (unless the frame is locked 
down). Notice the mouse pointer changes to four arrows when it is over the frame. When the 
mouse pointer is not over the selected frame, it is the default selection tool and does not allow the 
frame to be resized. In all cases, the displayed pointer indicates where and how the frame can be 
changed. 

When a frame is placed within another frame you may not be able to select it. Figure 21 shows a 
text box within a graph frame. 

 
If the graph was placed on the page before the text box, the graph will be selected instead of the 
text. This is because it is first in the View’s list of frames. When DataViewer® searches the list of 
frames for a possible selection, it will find the graph first and stop. To resolve this, you must send 
the graph frame to the end of the list. This is done by selecting the graph with the Select Frame 

tool and clicking on the Send To Back  toolbar icon. This will move the selected frame to the 
end of the list. The next time you click on the text box, it will be found in the list before the graph 
frame and will be selected instead of the Graph frame. 
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Alternatively, you can bring a frame to the beginning of the list by selecting it and clicking on the 

Bring To Front  toolbar icon. This will bring the selected frame to the beginning of the frame 
list. 

The properties of a frame can be modified at any time by right clicking the mouse with the Select 
Frame tool over it. This will display a context sensitive menu giving options relevant to the type of 
frame the mouse pointer is over. All frames will have a Properties menu option. Selecting the 
Properties menu option will display the frame’s corresponding properties dialog box. Change the 
properties as desired and select the OK button. 

15.3 Cutting, Copying, and Pasting Frames 
Professional Version  

DataViewer® allows you to move (cut) and copy frames from a page to a temporary holding place 
called the clipboard. You can then paste the frame and its contents to the same page, another 
page within the same view or another page in another view. In addition to the Windows® 
clipboard, DataViewer® maintains its own application clipboard for cutting and pasting frames. 
The application clipboard is used to cut and past frames within the DataViewer® application. 
When frames are cut, their contents are also copied to the Windows® clipboard. The Windows® 
clipboard is used for copying data between application. Items copied to the Windows® clipboard 
can be pasted into other applications that support this function. 

Use the Paste command to paste data in the application clipboard and the Paste Special 
command to paste from the Windows® Clipboard. The Paste Special command will paste the 
Windows® Clipboard data as an OLE frame. For more information on Paste Special see the Paste 
Special dialog box. 

For specific operations see 

15.4 Cutting a Frame  15.5 Copying a Frame  
15.6 Pasting a Frame  15.8 Copying a Frame to Another Page  
15.7 Moving a Frame to Another Page  

15.4 Cutting a Frame 
Professional Version  

Frames can be removed from a page at any time. To remove a frame and its contents from a 
page, perform the following steps: 

1. Select the frame to be removed with the selection tool. The selected frame will display the 
resize handles. 

2. Select the Cut command from the Edit menu or click on the Cut  toolbar icon. The frame 
will be removed from the page. 

The Cut menu command and the Cut toolbar icon are enabled only while a frame is selected. 

Note: A frame with attached child frames can not be removed from the page before all the 
attached child frames. 

See Also 

15.1 Modifying  a Frame  15.2 Selecting a Frame  
15.3 Cutting, Copying, and Pasting Frames  15.4 Cutting a Frame  
15.5 Copying a Frame  15.6 Pasting a Frame  
15.8 Copying a Frame to Another Page  15.7 Moving a Frame to Another Page  
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15.5 Copying a Frame 
Frames can be copied into the application and Windows® clipboards. Like the Cut Frame 
command, the contents of a frame is copied to the application and Windows® clipboard. Unlike 
the Cut command, the frame is not removed from the page, only copied to the clipboards. To 
copy a frame to the application and Windows® clipboards, perform the following steps: 

1. Select the frame to be copied with the selection tool. The selected frame will display the 
resize handles. 

2. Select the Copy command from the Edit menu or click on the Copy  toolbar icon. The 
frame and its contents will be copied to the application clipboard. The contents of the frame 
will also be copied to the Windows® clipboard. The frame will not be removed from the page. 

The Copy menu command and the Copy toolbar icon are enabled only while a frame is selected. 

See Also 

15.1 Modifying  a Frame  15.2 Selecting a Frame  
15.3 Cutting, Copying, and Pasting Frames  15.4 Cutting a Frame  
15.6 Pasting a Frame  15.8 Copying a Frame to Another Page  
15.7 Moving a Frame to Another Page  

15.6 Pasting a Frame 
Professional Version  

Frames previously cut or copied to the application clipboard can be pasted onto the same page 
they were copied (or cut) from. They can also be pasted onto another page within the same view 
or a page within another view. To paste a frame onto a page, perform the following steps: 

1. Scroll to the page that the frame is to be pasted on. 

2. Select the Paste command from the Edit menu or click on the Paste  toolbar icon. The 
frame and its contents currently in the application clipboard will be placed on the currently 
displayed page. 

The page the frame will be pasted onto is the current page. The current page is indicated in the 
page number pane on the status bar. For example, if the current page is number one of a two-
page view, the page number status pane will contain Page 1 of 2. 

The Paste command and the Paste toolbar icon are enabled only when a frame is in the 
application clipboard. 

See Also 

15.1 Modifying  a Frame  15.2 Selecting a Frame  
15.3 Cutting, Copying, and Pasting Frames  15.4 Cutting a Frame  
15.5 Copying a Frame  15.8 Copying a Frame to Another Page  
15.7 Moving a Frame to Another Page  

15.7 Moving a Frame to Another Page 
Professional Version  

When dragging a frame around in a view, you can only move it to another location on the same 
page. You can not drag it from one page to another. To move frames from one page to another, 
use the application clipboard as a temporary holding place. To move a frame from one page to 
another, perform the following steps: 

1. Select the frame to be removed with the selection tool. The selected frame will display the 
resize handles. 
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2. Select the Cut command from the Edit menu or click on the Cut  toolbar icon. The frame 
will be removed from the page. 

3. Scroll to the page the frame is to be pasted on, making sure that only the desired page is 
displayed. If part of the preceding page is displayed when the mouse is moved up to the 
toolbar or menu bar, the current page will change to that page as the mouse pointer passes 
over it. When the frame is pasted, it is pasted to the current page. 

4. Select the Paste command from the Edit menu or click on the Paste  toolbar icon. The 
frame will be pasted onto the current page. 

Once the frame is pasted onto the desired page, you can move it to anywhere on that page. 

See Also 

15.1 Modifying  a Frame  15.6 Pasting a Frame 
15.2 Selecting a Frame  15.8 Copying a Frame to Another Page 
15.3 Cutting, Copying, and Pasting Frames  15.4 Cutting a Frame  
15.5 Copying a Frame  

15.8 Copying a Frame to Another Page 
Professional Version  

When copying a frame within DataViewer®, it is copied to the current page. To copy a frame from 
one page to another, copy the frame from the page it is on, then scroll to the desired page and 
paste it. To copy a frame from one page to another, perform the following steps: 

1. Select the frame to be removed with the selection tool. The selected frame will display the 
resize handles. 

2. Select the Copy command from the Edit menu or click on the Copy  toolbar icon. The 
frame will be copied to the application and Windows® clipboard. 

3. Scroll to the page the frame is to be pasted on. Make sure that only the desired page is 
displayed. If part of the preceding page is displayed when the mouse is moved up to the 
toolbar or menu bar, the current page will change to that page as the mouse pointer passes 
over it. When the frame is pasted, it is pasted to the current page. 

4. Select the Paste command from the Edit menu or click on the Paste  toolbar icon. The 
frame will be pasted onto the current page. 

Once the frame is pasted onto the desired page, you can move it to anywhere on that page. 

See Also 

15.1 Modifying  a Frame  15.2 Selecting a Frame  
15.3 Cutting, Copying, and Pasting Frames  15.4 Cutting a Frame  
15.5 Copying a Frame  15.6 Pasting a Frame  
15.7 Moving a Frame to Another Page  

15.9 Locking a Frame in Place 
Professional Version  

When a frame is placed on a view, you are free to move it around and change its size. This also 
allows you to accidentally move or change its size. You can prevent this from occurring by locking 
the frame’s position and size. This is accomplished using the Lock Frame command. This 
command is accessible via the Frame menu and the popup menu. The popup menu is displayed 
by clicking the right mouse button, while the mouse cursor is over the desired frame. 

When a frame is locked, it will remain at a fixed location and size. Once a frame is locked, it will 
remain locked until it is unlocked via the Unlock Frame command. 

94 



III. Frames 

The Lock Frame command is only available when a frame is selected and the selected frame is 
unlocked. Once the selected frame is locked, the Lock Frame command will be grayed and the 
Unlock Frame command will be enabled. Also, while a frame is locked, the cursor does not 
change to the frame resize or move cursor. 

See Also 

5.14 Lock Frame command (Frame menu)  
15.10 Unlocking a Locked Frame  

15.10 Unlocking a Locked Frame 
Professional Version  

When a frame is placed on a view and locked in place (via the Lock Frame command), you can 
not move it around or change its size. This prevents you from accidentally moving or changing its 
size once placed at the location you want it to stay. If you later want to move or resize the frame, 
it must be unlocked first. This is accomplished using the Unlock Frame command. This command 
is accessible via the Frame menu and the popup menu. The popup menu is displayed by clicking 
the right mouse button while the mouse cursor is over the desired frame. 

While a frame is unlocked, it can be moved or resized. Once a frame is unlocked, it will remain 
unlocked until it is locked via the Lock Frame command. 

This command is only available when a frame is selected and the selected frame is locked in 
place. Once the selected frame is unlocked, the Unlock Frame command will be grayed and the 
Lock Frame command will be enabled. 

See Also 

5.15 Unlock Frame command (Frame menu)  
15.9 Locking a Frame in Place  

95 





 

IV. Obect Linking and Embedding 

CHAPTER 16: OLE 

16.1 Links command 
Professional Version  

When an OLE item is placed in the view, it can be copied into or linked to the original file. When 
copied into the view, changing the original file will have no effect on the object in the view. When 
linked to the file, it is not copied into the view and changes made to the original result in the 
embedded object changing, as well. 

Use this command to display a Links dialog box that lets you edit links between your document 
and other documents. 

This command is unavailable if you have no links in your document. 

16.2 Links dialog box 
Professional Version  

The Links dialog box displays the current links used in this document, their type, and update 
status. If the source file for the link can not be found, the update column will read Unavailable. 
This typically happens if the source file is on an unavailable network drive, or if the source file has 
been moved. 

When an entry in the Links list is selected, the Source and Type fields will be updated to reflect 
the selected link. In addition, the Update radio button, Update Now, Open Source, Change 
Source and Break Link buttons will become active for the selected link. 

The Update field specifies whether you want the selected link to be updated automatically or 
manually. If you select Automatic, whenever you change the linked information in the original 
document, the frame in the view will be updated automatically. If you select Manual, you need to 
click on the Update Now button when you want the frame to be updated. To change the update 
status of a link, click the link, and then Automatic or Manual. 

• Click the Cancel button to close the Links dialog before any changes are made. Once a link 
is modified, the Cancel button is replaced with the Close button. This indicates that changes 
have been made and applied to the selected link(s). 

• Click the Update Now button to update the corresponding frame with the selected link. 

• Click on the Open Source button to open the source file for the selected link. 

• Click on the Change Source button to change the source file for the selected link. 

• Click on the Break Link button to remove the connection between the selected link and the 
source file. When the link to the external file is broken, the frame becomes a static object and 
can no longer be edited. It will be fixed at the state when the link was broken. 

16.3 Object verb 
Professional Version  

The Object option in the Edit menu will change to reflect the type of OLE frame selected. For 
example, when selecting a bitmap linked object, it will be replaced with the text Linked Bitmap 
Image Object. This new entry can have up to three submenu commands: Edit, Open and 
Convert. 

The Edit option will open the object for editing. If it is a linked object, then the application will be 
started and the corresponding link file loaded into it. If the object was copied into the view (not 
linked), then it will be opened for in-place editing. 

97 



Printed Documentation 

Selecting Open will start the corresponding application to edit the object regardless of whether it 
is a link or copy. 

Selecting Convert will display the Convert dialog box. This dialog box lists the types of format 
conversions available, and allows you to perform the conversion. 

16.4 Insert Object command 
Professional Version  

Inserts a new frame into onto the current page in the current view.  The Frame Type dialog box 
will be displayed, allowing you to specify the type of frame to create. Select the type of frame you 
want to insert into your document using the Frame Type dialog box. 

16.5 Insert new object dialog box 
Professional Version  

This dialog box allows you to specify the object and how it is to be attached to the view. Click on 
Create New to create a new object to be insert into the view. The new object will be of the type 
you specify. Click on Create from File to insert an entire file into the view. The file will be inserted 
as an object that can be edited with the application that created it. 

• Create New: When creating new objects, select the Create New radio button. The Object 
Type list will be displayed. From this list, select the type of application specific object that is to 
be created. Use the scroll bar to view additional types. The Display As Icon check box 
specifies whether the embedded object will appear in the view as an icon or the actual 
contents of the object will be visible. While the Display As Icon item is checked, a Change 
Icon button will be available. Click this button to specify the icon to be displayed for the 
object. Once these items are specified, select the OK button. The OLE frame will be created 
and the corresponding application started for in place editing (if supported). 

• Create from File: When creating a new object, select the Create from File radio button. The 
File entry field will be displayed, which provides a space to type the name of the file you want 
to insert into the view. You can also use the Browse button to locate the file. Next, specify 
how the object is to be inserted into the view (Linked or Copied). This is done by placing (or 
not placing) a check beside the Link option. Checking the Link option will cause a link to the 
original file to be maintained. If this option is not checked, then the object will be embedded 
(copied) into the view. If the file is linked, changes made to the object in the view will appear 
in the original file, and changes made to the original file (via its corresponding application) will 
appear in the view. Once the options are specified, select the OK button. The object will be 
added to the view in the specified manner. 

16.6 Change icon dialog box 
Professional Version  

This dialog box allows you to specify the icon and its type to be displayed for the embedded 
object. 

• Current: Displays the icon that will appear in the current document. 

• Default: Specifies that the icon representing the embedded or linked information in your 
document is the default icon for the program that was used to create it. 

• From File: Specifies that the icon is from a file. A list of icons from the specified file will be 
displayed under the From File edit box. Select the icon to be used from the displayed list. If 
no icons are shown, then the specified file does not contain any or it cannot be found. 

Use the Browse button to search for a file containing icons. 
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The Label field provides a space for you to type a label for the icon as it will appear in your 
document. A default label is used unless you change it. 

16.7 Convert dialog box 
Professional Version  

The Convert dialog box allows you to convert the selected OLE frame from its current format to 
another format. The available types to convert to will depend on the type of OLE object the frame 
contains. The following is a list of each item in this dialog box and a description of its function: 

• Current Type: Lists the available file types that you can use to open the embedded or linked 
information. 

• Convert to: Radio button, which when selected, specifies that the object is to be converted to 
a different type. This is useful if you no longer have the program that was used to create the 
object, or if you want to display the object in a different format than the original type allows. 

• Activate as: Radio button, which when selected, specifies that the object is to be opened 
using a different program that is compatible with the original object type. 

• Object Type: Lists the available file types that you can use to open the embedded or linked 
object. 

• Results: Describes the operation that will be performed for the currently selected options. 
Notice, the text displayed, changes as options are changed. The displayed text describes 
whether the object will be converted to a different file type, what that file type will be, and how 
the object will appear in the frame. This is useful for experimenting with different conversions 
without actually implementing them. To implement the conversion, click the OK button. 

• Display As Icon: Specifies whether the embedded object will appear in the view as an icon, 
or the actual contents of the object will be displayed. If you select Display As Icon, you can 
open the object in the view by double-clicking its icon. When this option is checked, the 
Change Icon button is displayed, allowing you to select an alternate icon. Clicking on the 
Change Icon button will display the Change icon dialog box. 

• OK button: Closes the dialog box and saves changes you have made. 

• Cancel button: Closes the dialog box without saving any changes you have made. 
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CHAPTER 17: PRINTING 

17.1 Print command (File menu) 
Use this command to print a view.   This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other 
printer setup options. 

Shortcuts 

Toolbar:  
Keys: Ctrl+P 

17.2 Print dialog box 
The following options allow you to specify how the view should be printed: 

Printer 
This is the active printer and printer connection.  Choose the Setup option to change the 
printer and printer connection. 

Print to file 
Prints the view to a file instead of routing it directly to a printer. 

Properties 
Displays a Printer Setup dialog box specific to the selected printer, so you can select various 
printer options. 

Print Range 
Specify the pages you want to print: 

All Prints the entire view. 

Pages Prints the range of pages you specify in the From and To 
boxes.  If the view contains only one page then this option is 
grayed. 

Selection Prints the currently selected frame. 

Copies 
Specify the number of copies you want to print for the above page range. 

17.3 Print Progress Dialog 
The Printing dialog box is shown during the time that DataViewer® is sending output to the printer.  
The page number indicates the progress of the printing. 

To abort printing, choose Cancel. 
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17.4 File Print Preview command 
Use this command to display the active view as it would appear when printed.  When you choose 
this command, the main window will be replaced with a print preview window, in which one or two 
pages will be displayed in their printed format.  The Print Preview Toolbar offers you options to 
view either one or two pages at a time; move back and forth through the view; zoom in and out of 
pages; or, initiate a print job. 

Shortcuts 

Toolbar:  

See Also 

17.12 Changing the Page Layout  
17.14 Print Preview  
17.15 Printing the View  

17.5 Print Preview Toolbar 
The print preview toolbar offers you the following options: 

Print 
Bring up the print dialog box, to start a print job. 

Next Page 
Preview the next printed page. 

Prev Page 
Preview the previous printed page. 

One Page / Two Page 
Preview one or two printed pages at a time. 

Zoom In 
Take a closer look at the printed page. 

Zoom Out 
Take a larger look at the printed page. 

Close 
Return from print preview to the editing window. 

17.6 File Page Setup Command 
Use this command to display the Page Setup dialog box.  This dialog box allows you to change 
the layout of the page used in displaying and printing the view. 

See Also 

17.12 Changing the Page Layout  
17.7 Page Layout Operations  
17.13 Printing Operations  
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17.7 Page Layout Operations 
As mentioned previously, DataViewer® uses a page publishing style of report generation. The 
report is presented in the view, which can contain any number of pages. Pages can be added and 
removed as needed. The next few sections describe the process of adding and removing pages, 
as well as, setting the page size, margins and orientation used in the view. 

The following are specific page operation topics: 

17.8 Adding a Page to the View  
17.10 Removing a Page from the View  
17.12 Changing the Page Layout  

17.8 Adding a Page to the View 
Professional Version  

To add a page to the currently active view, perform the following steps: 

1. Select the Add Page command from the Edit menu. The Insert Page dialog box will be 
displayed. This dialog box allows you to insert a page before or after a specified page. The 
page number defaults to the currently displayed page. The number of the current page is 
given on the status bar and reflects the last page the mouse pointer was over before 
selecting the Add Page command. 

2. Change the page number, if needed, and specify if the new page is to go before or after the 
specified page. For example, to insert a page before the first page in the view, set the page 
number to 1 and select Before specified page. 

3. Once the page number and insertion mode are specified, click the OK button. The new page 
will be inserted into the view at the specified location. All pages in the view will be 
renumbered as needed and the frames on those pages will be moved along with them. 

See Also 

17.10 Removing a Page from the View  
17.12 Changing the Page Layout  

17.9 Insert Page dialog box 
Professional Version  

The Insert Page dialog box allows you to specify where and how a new page is to be added to 
the view. Specify a page number and whether the new page should be inserted before or after 
this specified page. 

For example to add a page to the start of the view (before page 1), specify the page number as 1 
and select the Before specified page option. To add a page between pages 2 and 3, specify the 
page number as 2 and select After specified page. 

See Also 

3.8 Add Page command (Edit menu)  
3.9 Delete Page command (Edit menu)  
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17.10 Removing a Page from the View 
Professional Version  

In addition to adding pages to a view, they can be deleted, as well. When deleting a page from a 
view, all the frames contained on that page will be deleted, as well. Unlike the Cut command, 
frames deleted in this manner will not be copied to the application and Windows® clipboards. For 
this reason, be very careful not to delete the wrong page. To remove a page from the currently 
active view, perform the following steps: 

1. Select the Delete Page command from the Edit menu. The Delete Page dialog box will be 
displayed. This dialog box allows you to specify which page is to be deleted. The page 
number defaults to the currently displayed page. The number of the current page is given on 
the status bar, and reflects the last page the mouse pointer was over before selecting the 
Delete Page command. 

2. Change the page number, if needed, to the number of the page you want deleted. 
3. Once the page number is specified, click the OK button. If any frames are currently on the 

specified page, a dialog box asking for confirmation to delete the page will be displayed. This 
dialog box is displayed only when the page to be deleted contains frames. Continuing with 
the deletion of the specified page will also delete all the frames contained on that page. If you 
still want to delete the page, then click on the Yes button. Otherwise, click on the No button 
and the delete page process will be canceled. If the specified page does not contain any 
frames, then this dialog box is not displayed and the page is simply deleted. 

See Also 

17.8 Adding a Page to the View  
17.12 Changing the Page Layout 

17.11 Delete Page dialog box 
Professional Version  

The Delete Page dialog box allows you to specify the page to be removed from the view. The 
page number is initialized to the currently viewed page. 

Specify the page to be deleted and press the OK button. If the page being deleted contains 
frames, a dialog box will be displayed asking for confirmation to continue with the operation. 
Selecting Yes will continue and selecting No will cancel the operation. 

As previously mentioned, when a page is deleted all the frames contained on that page are 
deleted, as well. If there are more frames on the page than can be added to the undo buffer, a 
warning dialog will be displayed. In which case, you will not be able to undo the delete page 
operation, if you proceed. If the frames will fit on the undo buffer, no warning is displayed and the 
delete page operation can be undone (up until the point another operation pushes it out of the 
undo buffer). 

To close this dialog without deleting a page, press the Cancel button. 

See Also 

3.9 Delete Page command (Edit menu)  
3.8 Add Page command (Edit menu)  

17.12 Changing the Page Layout 
The layout and size of the pages used in a view are by default, 8.5" x 11" in size with a 0.5" 
margin around all sides. To change the page layout, perform the following steps: 

1. Select the Page Setup option from the File menu. The page setup dialog box will be 
displayed. This dialog box allows you to select the paper size and source. The selected 
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printer determines both of which. New views will use the default printer and will therefore 
present that printer’s available options. 

2. Select an alternate printer by clicking on the Printer button. The Page Setup Printer dialog 
box will be displayed. 

3. Select an alternate printer from the drop down list. 
4. You can also change the printer’s specific setup by clicking on the Properties button. The 

dialog box displayed will be specific to the printer selected in the Page Setup Printer drop 
down list. Please refer to your printer documentation for specifics on this printer. Once the 
printer setup is set, click on the OK button to return to the Page Setup Printer dialog box. 

5. Next, click on the OK button to accept the selected printer and return to the Page Setup 
dialog box. 

6. Select the size of the paper from the Size drop down list. 
7. Select the paper source from the Source drop down list. 
8. Select the page orientation (portrait or landscape) by clicking on the corresponding radio 

button. 
9. Specify the left, right, top and bottom margins by clicking on the corresponding field and 

editing the value. The margins are relative to the corresponding side of the page. For 
example, the right margin specifies the amount to come in from the right side of the page. 

10. Select the OK button to change the page layout for the active view to the specified settings. 
Select the Cancel button to leave the views page layout as it was. 

When the view is saved, the page layout, printer and printer setup used to display it are also 
saved. This helps insure that the WYSIWYG aspect of a view is maintained, even if the default 
Windows® printer is changed after the view is created. 

See Also 

17.13 Printing Operations  
15.1 Modifying  a Frame  
17.7 Page Layout Operations  

17.13 Printing Operations 
Once the view has been created, it can be printed to produce a hardcopy report. You can print 
views to any of the installed Windows® printers and page sizes. Different printers and page sizes 
are selected through the Page Setup and Print Setup dialog boxes. Refer to the previous section 
on Page Layout for instructions on changing the page setup. 

The following a specific printing operation topics: 

17.12 Changing the Page Layout  
17.14 Print Preview  
17.15 Printing the View  

17.14 Print Preview 
Although DataViewer® uses a WYSIWYG display of frames, it is not always exactly as it would be 
when printed. To get a closer view of what the printed pages will look like, you can preview them. 
To preview the printed pages, perform the following steps: 

1. Select the Print Preview command from the File menu or click on the Print Preview  
toolbar icon. DataViewer® will enter the print preview mode. This screen displays the first 
page in the view in its entirety. You can quickly see how the frames will appear on the printed 
page. 
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2. If the view contains more than one page, the Next Page button will be enabled. Clicking on 
this button will display the page following the one currently displayed. If this is the only page 
or last page in the view, the Next Page button will be grayed and disabled. 

3. If the displayed page is not the first, then the Prev Page button will be enabled. Clicking on 
this button will display the page preceding the one currently displayed. If this is the only page 
or the first page in the view, then the Prev Page button will be grayed and disabled. 

4. If the view contains more than one page and the pages are displayed at the lowest 
magnification (full-page display), the Two-Page button will be enabled. Clicking on this button 
will display two pages, side by side, and the Two-Page button will be renamed to One-Page. 
Clicking on this button again will return DataViewer® to displaying a single page at a time. 

5. When the entire page is displayed (lowest magnification), the mouse pointer becomes a 
magnifying glass. Clicking the left mouse button, while the pointer is over the page, will 
increase the magnification of the selected area. Clicking the left mouse button again will 
further increase the magnification. This time, the mouse pointer will become a selection 
arrow, indicating that you are at the maximum magnification. Clicking the left mouse button 
over the page will reset the magnification, such that the entire page is displayed (reset to 
lowest magnification). Also, notice that while you are viewing at increased magnification, the 
Two-Page button is disabled. You can only view two pages while at the lowest magnification. 
In addition, if you are viewing two pages prior to increasing the magnification, the selected 
page will be displayed at the higher magnification. 

6. As with the magnifying glass mouse pointer, clicking the Zoom In button will increase the 
display magnification. Clicking on the Zoom In button a second time will display the page at 
the maximum magnification. When viewing at maximum magnification, the Zoom In button is 
disabled. 

7. When viewing a page at an increased magnification, the Zoom Out button is enabled. 
Clicking on the Zoom Out button will decrease the display magnification. When viewing the 
page at the lowest magnification, the Zoom Out button is disabled. 

8. Clicking on the Print button will close the preview window and automatically bring up the print 
dialog box, at which point you can print all or selected pages of the view. Refer to the 
following section on printing the view. 

9. Clicking on the Close button will close the preview window and return you to normal operation 
of DataViewer®. 

When selecting print preview, the active view enters the preview mode. Any other open views can 
be selected and operated while this view is still in preview mode. Preview mode is a special 
display mode that emulates the printed page. While in preview mode, the pages can only be 
viewed but not modified. 

See Also 

17.12 Changing the Page Layout  
17.15 Printing the View  

17.15 Printing the View 
Once the data has been viewed and analyzed, a hard copy report of the view may be desired. All 
views displayed by DataViewer® can be printed, as well. To print the active view, perform the 
following steps: 

1. Select the Print command from the File menu, or click on the Print  toolbar icon. The 
Print dialog box will be displayed. This dialog box allows you to select an alternate printer and 
change its properties. If you change the printer here and continue with the print operation, 
you will not be able to preview the pages before they are printed. The printed pages may not 
appear as they did while viewing because they were printed using a different driver. For this 
reason, it is suggested that you first change the printer using the Print Setup command, 
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preview the pages with the new printer, then print the pages. This will help ensure that the 
printed pages are what you wanted. 

2. If the view to be printed has more than one page, you will be able to specify the Print range. 
You can select all pages or a range of pages. If the view only has one page, then All is the 
only Print range selection available. 

3. If the selected printer supports making copies, you will be able to specify the number of 
copies of the specified pages to print. If the printer does not support making copies, then the 
Number of copies option will be grayed. 

4. Once all the desired selections are made, click on the OK button to start printing. If you 
decide not to print the view, click on the Cancel button and the dialog box will close without 
printing. 

See Also 

17.12 Changing the Page Layout  
17.14 Print Preview  
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CHAPTER 18: TEMPLATES 

18.1 Templates 
A template is a file that defines the type, placement and properties of frames in a view. Unlike a 
view, a template does not have a database attached to it. That is, any frames in the template that 
display the contents of a database, do not contain the name of a database. Alternatively, a view is 
a template that has the name(s) of the database(s) specified in it. 

The main difference between a view and a template is the file name extension. When a view is 
opened, the specified databases are opened and loaded, as well. When a template is opened, 
the user is asked to specify the name(s) of the database file(s) needed, at which point the 
template is attached to the database and becomes a view. 

DataViewer® comes with a set of templates, each for a specific type of instrument and 
configuration. 

A template is attached to a database by any of the following methods: 

• Downloading instrument data. 

• Opening a template. 

• Opening a database. 

See the following for specific template operations: 

18.2 Create View from Template dialog  
18.3 Attach Template when Downloading Data  
18.5 Attach Template when Opening a Database  
18.4 Attach Database when Opening a Template  
18.6 Creating a Template  
18.7 Modifying a Template  

18.2 Create View from Template dialog 
The Create View from Template dialog box allows you to select, in one-place, template and 
database files to be joined to create a view. 

This dialog box contains the following items: 

• Template Name Field: Specifies the template to be used in the creation of a view. This field 
is specified via the Browse button or by selecting a template from the Templates List Box. 

• Template Browse Button: This button (located next to the Template Name field) allows you 
to select (via an open file dialog) a desired template file. 

• Template Groups List Box: Lists the groups (directories) found in the Templates directory. 

• Templates List Box: Lists the templates within the selected group. 

• Database List Box: Indicates the number of databases needed to fulfill the requirements of 
the specified template. 

• Database Browse Button: This button (located next to the Database list box) allows you to 
select (via an open file dialog) desired database files. 

The process of creating a view is performed in the following steps: 

1. Specify the template to use. 
2. Specify database (or databases) to be viewed. 
3. Select the OK button. 
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Each step must be completed in order. The template must be selected before a database can be 
selected. The database list must be completed before the OK button can be selected. The 
controls for each step are disabled until the preceding step is completed. 

Depending on how this dialog box was invoked, the template or database entries may already be 
specified. For example, when invoked from the Quick Start dialog box by selecting the Create 
New View From Template button, neither of the two steps are completed. When invoked by 
selecting a database to open, or after downloading data from an instrument, Step 2: Specify 
Database will contain the name of the database previously specified. When invoked by selecting 
a template to open, Step 1: Specify Template will contain the name of the template previously 
specified. 

A template is specified by, either selecting one via the Browse button, or by selecting one from 
the Templates list. When using the Browse button, an Open file dialog box is displayed. Use this 
dialog box to locate and select a template not in one of the groups.  To select a template from a 
group, first select the corresponding entry in the Groups list box.  The Templates list will be 
updated to reflect the templates within the selected group.  Then select a template from the 
Templates list box. 

When a template is selected, it is scanned to identify the number of databases it requires. The 
number of databases is indicated in the Specify Database list box. For example, selecting a 
template that calls for two different databases, results with 1: and 2: entries appearing in the 
database list box. 

If the Create View for Template dialog box was invoked by selecting a database to be opened, 
the Specify Database list will be initialized with 1: DatabaseName (where DatabaseName is the 
name of the previously selected database) as the first and only entry. Subsequent selection of a 
template will use this database name as the first, and add empty entries for any additionally 
required databases. 

Once the template has been specified, the database can be selected using the Browse button 
located next to the Database list. If the database(s) have already been specified (either prior to 
invoking this dialog or by selecting the Browse button), and none of these database entries are 
selected, the Browse database button is disabled. 

A listed database entry can be changed by, first selecting the database entry, then selecting the 
Browse button. When specifying a database, the highlighted database entry is modified. If no 
database entry is selected and entries remain to be specified, selecting the Browse button sets 
the first unspecified database entry. If all database entries are specified, and none of these 
entries are selected, the Browse database button is disabled. 

See the following for specific template operations 

18.3 Attach Template when Downloading Data  
18.5 Attach Template when Opening a Database  
18.4 Attach Database when Opening a Template  
18.6 Creating a Template  
18.7 Modifying a Template  

18.3 Attach Template when Downloading Data 
A template can be attached to a database at the time the database is created. The process of 
downloading, saving and viewing data from an instrument takes the following steps: 

1. Select Download from the Instrument menu. The Connection dialog box is displayed. 
2. Select the communications port and rate from the drop down list boxes. 
3. Select the OK dialog button. A connection with the instrument will be established and any 

data currently stored in it will be downloaded. 
4. Once the download is complete, the Save As dialog will be displayed. Specify the name to 

save the database under. 

110 



VI. Templates 

5. Specify the Session Properties. 
6. A dialog box will be displayed, indicating the success or failure of the data decode process. 

Assuming the data decode was successful, select the OK button and continue. If an error 
was reported, resolve the error before proceeding. 

7. Answer yes to the question, "Do you want to open database just downloaded?" The Create 
View from Template dialog will be displayed. 

8. Select the template to use for the initial display of the database. See Create View from 
Template dialog for more information about this dialog box. 

9. Select the OK button in the Create View from Template dialog box. 
10. Customize each object frame as desired. 
Once the Create View from Template dialog box is closed and the transformation is specified, 
the resulting view will be displayed, at which point you can view and manipulate it as desired. 

See Also 

18.2 Create View from Template dialog  
18.1 Templates  

18.4 Attach Database when Opening a Template 
When a template is opened, the user is asked to supply the name(s) of the database(s) needed 
to complete its display. When the database(s) are specified, they are attached to the template 
and it becomes a view. 

The following steps illustrate the procedure of opening a template and creating a view: 

1. Select the Open option from the File menu. 
2. Select DataViewer Template Files (*.dvt) from the Files of type: drop down list. 
3. Select or specify the name of the template file. 
4. Select the Open button. The Create View from Template dialog will be displayed. 
5. Specify the name of each database file needed to complete the transformation of the 

template to a view. See Create View from Template dialog box for more information. 
6. Select the OK button in the Create View from Template dialog box. 
7. Customize each object frame as desired. 
Once the Create View from Template dialog box is closed and the transformation is specified, 
the resulting view will be displayed, at which point you can view and manipulate it as desired. 

See Also 

18.2 Create View from Template dialog  
18.1 Templates  

18.5 Attach Template when Opening a Database 
When a database is opened, the user is asked to supply the name of the template to define its 
display. When the template is specified, it is attached to the database resulting in a view. 

The following steps illustrate the procedure of opening a database and creating a view: 

1. Select the Open option from the File menu. 
2. Select DataViewer Database Files (*.dvb) from the Files of type: drop down list. 
3. Select or specify the name of the database file. 
4. Select the Open button. The Create View from Template dialog will be displayed. 
5. Select the template to use for the initial display of the database. See Create View from 

Template dialog for more information. 
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6. Specify any additional databases (if any) required by the selected template. 
7. Select the OK button in the Create View from Template dialog box. 
8. Customize each object frame as desired. 
9. Once the Create View from Template dialog box is closed and the transformation is 

specified, the resulting view will be displayed, at which point you can view and manipulate it 
as desired. 

See Also 

18.2 Create View from Template dialog  
18.1 Templates  

18.6 Creating a Template 
Professional Version  

A template is created when a view is saved with the database detached. The following steps 
illustrate the procedure of creating a new template: 

1. Open an existing view or create a new one. 
2. Modify the view as desired. 
3. Select the Save As Template option from the File menu. 
4. Specify the name of the template in the File name: field. 
5. Select the Save button. 
That’s all it takes to create a template. 

See Also 

18.1 Templates  
18.4 Attach Database when Opening a Template  
18.3 Attach Template when Downloading Data  
18.5 Attach Template when Opening a Database  

18.7 Modifying a Template 
Professional Version  

A template can only be modified when it is a view. Templates are not modified in their native 
format and only when the data to be displayed is attached. The following steps illustrate the 
procedure of modifying a template: 

1. Select the Open option from the File menu. 
2. Select DataViewer Template Files (*.dvt) from the Files of type: drop down list. 
3. Select or specify the name of the template file. 
4. Select the Open button. The Create View from Template dialog will be displayed. 
5. Specify the name of each database file needed to complete the transformation of the 

template to a view. See Create View from Template dialog for more information about this 
dialog box. 

6. Select the OK button in the Create View from Template dialog box. 
7. Customize each object frame, as desired. 
8. Save the view as a template using the name specified in step 3. See Creating a Template for 

steps to complete this process. 
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A new template, based on an existing template, can be created using the previous procedure, 
except specify a different name in step 7. The original template will be left as is and a new one 
with the specified name created. 

See Also 

18.1 Templates  
18.6 Creating a Template  

113 





 

VII. Zooming 

CHAPTER 19: ZOOMING 

19.1 Zooming 
Frames displaying graphs of trend and waveform measurement data allow for a number of 
display extent commands. These commands allow you to indicate the starting and ending times 
of the displayed data. By changing the start and ending display times, you can zoom in, zoom 
out, pan left and right, pan to start and pan to end of measurement data. Each of these 
commands can be selected from the Zoom menu or from the toolbar. Each of these commands 
and their associated operation is discussed in the following sections. 

For specific operations see 

Zoom Operations 

19.5 Zoom In  
19.6 Zoom Out  
19.3 Zoom Previous  
19.4 Zoom All  
  

Panning Operations 

19.7 Panning  
19.10 Pan Left  
19.11 Pan Right  
19.12 Pan To Start  
19.13 Pan To End  

19.2 Zoom To Selection 
When a graph frame is first created, the displayed channels are shown in the full time extents of 
the stored data. You can zoom in on a selected area using the Zoom Tool. To zoom to a selected 
area of a graph, perform the following steps: 

1. Select the Zoom Tool command from the Zoom menu or click on the Zoom Tool  
toolbar icon. This will enable the zoom selection tool. The mouse pointer will change to this 
tool while it is over a graph that supports zooming. When the mouse pointer is not over a 
frame or area of a frame that supports zooming, the mouse pointer becomes the default 
selection tool. 

2. Move the zoom selection tool to the location of the graph that will become the upper left 
corner of the displayed extents. 

3. Click and hold the left mouse button. 
4. Drag the mouse to the location on the graph where the lower right corner of the display 

extents is to be located. Notice as you move the mouse pointer, a dotted box is displayed. 
This dotted box shows the area of the graph that will become the displayed extents. 

5. Release the mouse button. The graph will be redrawn to the new extents indicated by the 
zoom selection box. 

This tool performs a "zoom to selected area" operation, hence the name Zoom Selection tool. 
This process can be repeated, as needed. 

See Also 

19.1 Zooming  
19.7 Panning  
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19.3 Zoom Previous 
When zoom operations are performed, the display extents prior to zooming are saved. This 
allows you to undo any zoom operation and return to the previously displayed extents. To undo a 
zoom operation and return to the previous display extents perform the following steps: 

1. Select the graph frame you wish to zoom to previous extents, using the Select Frame  

or the Zoom Selection  tool. The selected frame will be displayed with resize handles. If 
the selected graph has previously been zoomed, the Zoom Previous menu command and 

Zoom Previous  toolbar icon will be enabled. If a previous zoom extent is not available, 
the menu option and toolbar icon will be grayed. 

2. Select the Zoom Previous command from the Zoom menu or click on the Zoom Previous 

 toolbar icon. The graphs display extents will be reset to the extents prior to the last 
zoom operation. 

The Zoom Previous operation can be repeated until no previous display extents are available. For 
example, if you zoom into the graph twice you will be able to select the Zoom Previous command 
twice. If you zoom in twice, zoom previous once and zoom in again you will be able to zoom out 
twice. The zoom previous operates like a stack of plates. Each time a zoom in operation is 
performed, a previous zoom operation is placed on the stack. If five zoom previous operations are 
available and you zoom previous once, four more are still available. Zooming in with those four 
still on the stack gives you a total of five available, four from the original set and one new one. 
You can zoom in and back out as you wish. 

Each graph frame has its own Zoom Previous extents stack and is independent of all others. 

See Also 

19.1 Zooming  
19.7 Panning  

19.4 Zoom All 
To display the graph in the full extents to the stored data, perform the following steps: 

1. Select the graph frame you wish to zoom all extents, using the Select Frame  or the 

Zoom Selection  tool. Selecting the tool and clicking on the graph does this. The 
selected frame will be displayed with resize handles. 

2. Select the Zoom All command from the Zoom menu. The graphs display extents will be reset 
to the full extents of the stored data. 

See Also 

19.1 Zooming  
19.7 Panning  

19.5 Zoom In 
The Zoom Selection tool allows you to zoom into a selected area of a graph. Another zoom option 
is to zoom in by a defined amount. The Zoom In command allows you to increase the 
magnification of a displayed graph by some amount. By default, this amount is 200% but can be 
change to any amount you wish. When the zoom operation is selected, the new display extents 
will be centered on the display extents. To zoom in on the center of the display extents, perform 
the following steps: 
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1. Select the graph frame you wish to zoom in on, using the Select Frame  or the Zoom 

Selection  tool. The selected frame will be displayed with resize handles. If the selected 

frame supports zooming, the Zoom In menu command and Zoom In  toolbar icon will be 
enabled. If the frame does not support zooming, the menu option and toolbar icon will be 
grayed. 

2. Select the Zoom In command from the Zoom menu or click on the Zoom In  toolbar 
icon. The graph’s display extents will be reset to increase the magnification by the set 
amount. This amount is 200% by default but can be changed under User Options. 

This zoom operation will place the previous display extents on the Zoom Previous extents stack 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

This zoom operation always zooms to the center of the displayed graph. You can zoom to a 
selected point on the graph using the Zoom Selection tool. This is done by double clicking on the 
point on the graph to zoom into. This has the same effect as drawing a zoom selection box half 
the size of the displayed graph centered around the chosen point. This is a fast way of drilling 
down into the displayed data. This method of zoom also places a display extents entry on the 
Zoom Previous stack and can be undone. 

See Also 

19.1 Zooming  
19.7 Panning  

19.6 Zoom Out 
All the previous zoom commands (with the exception of the Zoom Previous command) provide a 
mechanism to zoom in on a graph. Another zoom option, which allows you to zoom out or step 
back on a graph, is the Zoom Out command. The Zoom Out command allows you to decrease 
the magnification of a displayed graph by some amount. By default, this amount is 200% but can 
be change to any amount you wish. When the Zoom Out operation is selected, the new display 
extents will be centered on the current display extents. To zoom out on the center of the display 
extents, perform the following steps: 

1. Select the graph frame you wish to zoom out on using the Select Frame  or the Zoom 

Selection  tool. The selected frame will be displayed with resize handles. If the selected 

frame supports zooming, the Zoom Out menu command and Zoom Out  toolbar icon will 
be enabled. If the frame does not support zooming, the menu option and toolbar icon will be 
grayed. 

2. Select the Zoom Out command from the Zoom menu or click on the Zoom Out  toolbar 
icon. The graph’s display extents will be reset to decrease the magnification by the set 
amount. This amount is 200% by default but can be changed under User Options. 

This zoom operation will place the previous display extents on the Zoom Previous extents stack 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

See Also 

19.1 Zooming  
19.7 Panning  
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19.7 Panning 
All of the previous zoom operations change the start time and duration of the data to be 
displayed. This has the effect of zooming in or out of an area of the graph. Another method of 
changing the display extents is called panning. Unlike zooming, panning only changes the start 
time and not the magnification of the displayed graph. Panning is like looking at a picture through 
a small box. The box is smaller than the picture in your view. Sliding the box left and right lets you 
look at the rest of the picture, a portion at a time. The following section shows how you can pan 
left, right, to the start and to the end of the graph data. 

See Also 

19.8 Step Left  19.9 Step Right  
19.10 Pan Left  19.11 Pan Right  
19.12 Pan To Start  19.13 Pan To End  
19.1 Zooming  

19.8 Step Left 
Stepping left, slides the viewing area to display the graph to the left (lower in time) of the currently 
displayed graph extents. To step a graph to the left, perform the following steps: 

1. Select the graph frame you wish to step left on, using the Select Frame  or the Zoom 

Selection  tool. The selected frame will be displayed with resize handles. If the selected 

frame supports panning, the Step Left menu command and Step Left  toolbar icon will 
be enabled. If the frame does not support panning, the menu option and toolbar icon will be 
grayed. In addition, this command is disabled if the starting channel data is already displayed. 

2. Select the Step Left command from the Zoom menu or click on the Step Left  toolbar 
icon. The graph’s starting display time will be decreased by 10% of the display duration. This 
has the effect of sliding the graph window to the left, leaving 90% of the previous extents 
displayed. This default of 10% can be changed under User Options. 

This pan operation will place the previous display extents on the Zoom Previous extents stack, 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

The Step Left command performs the same basic operation as the Pan Left command. The 
difference being, each has their own customizable default shift rates. By default, the step 
operation shifts the displayed graph by 10%, while the pan operation shifts the displayed graph 
by 90%. 

See Also 

19.1 Zooming  
19.7 Panning  

19.9 Step Right 
Stepping right, slides the viewing area to display the graph to the left (higher in time) of the 
currently displayed graph extents. To pan a graph to the right, perform the following steps: 

1. Select the graph frame you wish to step right on, using the Select Frame  or the Zoom 

Selection  tool. The selected frame will be displayed with resize handles. If the selected 

frame supports panning, the Step Right menu command and Step Right  toolbar icon 
will be enabled. If the frame does not support panning, the menu option and toolbar icon will 
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be grayed. In addition, this command is disabled if the ending channel data is already 
displayed. 

2. Select the Step Right command from the Zoom menu or click on the Step Right  toolbar 
icon. The graph’s starting display time will be increased by 10% of the display duration. This 
has the effect of sliding the graph window to the right, leaving 90% of the previous extents 
displayed. This default of 10% can be changed under User Options. 

This pan operation will place the previous display extents on the Zoom Previous extents stack, 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

The Step Right command performs the same basic operation as the Pan Right command. The 
difference being, each has their own customizable default shift rates. By default, the step 
operation shifts the displayed graph by 10%, while the pan operation shifts the displayed graph 
by 90%. 

See Also 

19.1 Zooming  
19.7 Panning  

19.10 Pan Left 
Panning left slides the viewing area to display the graph to the left (lower in time) of the currently 
displayed graph extents. To pan a graph to the left, perform the following steps: 

1. Select the graph frame you wish to pan left on using the Select Frame  or the Zoom 

Selection  tool. The selected frame will be displayed with resize handles. If the selected 

frame supports panning, the Pan Left menu command and Pan Left  toolbar icon will be 
enabled. If the frame does not support panning, the menu option and toolbar icon will be 
grayed. In addition, this command is disabled if the starting channel data is already displayed. 

2. Select the Pan Left command from the Zoom menu or click on the Pan Left  toolbar 
icon. The graph’s starting display time will be decreased by 90% of the display duration. This 
has the effect of sliding the graph window to the left, leaving 10% of the previous extents 
displayed. This default of 90% can be changed under User Options. 

This pan operation will place the previous display extents on the Zoom Previous extents stack 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

The Pan Left command performs the same basic operation as the Step Left command. The 
difference being, each has their own customizable default shift rates. By default, the step 
operation shifts the displayed graph by 10%, while the pan operation shifts the displayed graph 
by 90%. 

See Also 

19.1 Zooming  
19.7 Panning  
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19.11 Pan Right 
Panning right slides the viewing area to display the graph to the left (higher in time) of the 
currently displayed graph extents. To pan a graph to the right perform the following steps: 

1. Select the graph frame you wish to pan right on, using the Select Frame  or the Zoom 

Selection  tool. The selected frame will be displayed with resize handles. If the selected 

frame supports panning, the Pan Right menu command and Pan Right  toolbar icon will 
be enabled. If the frame does not support panning, the menu option and toolbar icon will be 
grayed. In addition, this command is disabled if the ending channel data is already displayed. 

2. Select the Pan Right command from the Zoom menu or click on the Pan Right  toolbar 
icon. The graph’s starting display time will be increased by 90% of the display duration. This 
has the effect of sliding the graph window to the right, leaving 10% of the previous extents 
displayed. This default of 90% can be changed under User Options. 

This pan operation will place the previous display extents on the Zoom Previous extents stack, 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

The Pan Right command performs the same basic operation as the Step Right command. The 
difference being, each has their own customizable default shift rates. By default, the step 
operation shifts the displayed graph by 10%, while the pan operation shifts the displayed graph 
by 90%. 

See Also 

19.1 Zooming  
19.7 Panning  

19.12 Pan To Start 
The Pan Left and Pan Right commands slide the displayed graph by an amount determined by 
the display duration. You can repeatedly pan left or right until the start or end of the channel data 
is reached. You can jump to the beginning of the channel data using the Pan To Start command. 
To pan to the start of the channel data, perform the following steps: 

1. Select the graph frame you wish to pan to the start of, using the Select Frame  or the 

Zoom Selection  tool. The selected frame will be displayed with resize handles. If the 

selected frame supports panning, the Pan To Start menu command and Pan To Start  
toolbar icon will be enabled. If the frame does not support panning, the menu option and 
toolbar icon will be grayed. In addition, this command is disabled if the starting channel data 
is already displayed. 

2. Select the Pan To Start command from the Zoom menu or click on the Pan To Start  
toolbar icon. The graph will be displayed, starting with the beginning of the channel data 
using the same magnification. 

This pan operation will place the previous display extents on the Zoom Previous extents stack, 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

See Also 

19.1 Zooming  
19.7 Panning  
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19.13 Pan To End 
As with the Pan To Start command, you can pan all the way to the end of the channel data. To 
pan to the end of the channel data, perform the following steps: 

1. Select the graph frame you wish to pan to the end of, using the Select Frame  or the 

Zoom Selection  tool. The selected frame will be displayed with resize handles. If the 

selected frame supports panning, the Pan To End menu command and Pan To End  
toolbar icon will be enabled. If the frame does not support panning, the menu option and 
toolbar icon will be grayed. In addition, this command is disabled if the ending channel data is 
already displayed. 

2. Select the Pan To End command from the Zoom menu or click on the Pan To End  
toolbar icon. The graph will be displayed, such that, it ends with the last sample for the 
recorded channels. 

This pan operation will place the previous display extents on the Zoom Previous extents stack, 
allowing it to be undone. Refer to the Zoom Previous command for a detailed explanation of this 
feature. 

See Also 

19.1 Zooming  
19.7 Panning  
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